GeneMapper® ID-X Software
Version 1.2
GeneMapper® ID-X Software
Version 1.2
Contents

Preface .......................................................... vii
How to use this guide ........................................ vii
How to obtain support ...................................... x

Chapter 1  Getting Started ................................. 1
Start here: Getting the most out of this guide .............. 2
Installation options .......................................... 3

Chapter 2  Installation Requirements. .............. 13
Installation CDs ............................................... 14
Full installation computer requirements ..................... 16
Client installation computer requirements .................. 18
Verifying your computer setup ............................. 19
Analyzers and compatible software ....................... 20
Chapter 3
Performing GeneMapper® ID-X v1.2 Pre-Installation Procedures..................................21
Overview..............................................................................................................22
Requirements for upgrading GeneMapper® ID v3.1 to
GeneMapper® ID v3.2 .........................................................................................24
Exporting GeneMapper® ID v3.2.x data ..............................................................24
  Using the export utility
  (GeneMapper® ID v3.2.x software only) .........................................................25
Uninstalling the GeneMapper ID v3.2 and GeneMapper ID-X
v1.0/1.0.1/1.1/1.1.1 software ............................................................................28
Enabling autoanalysis ..........................................................................................31
  Starting the Data Collection Software on the Data Collection
  computer ............................................................................................................32
  Obtaining the Data Collection computer name ............................................35
Obtaining the GeneMapper® ID-X Software
host computer name ............................................................................................37

Chapter 4
Performing a New Software Installation ..........................................................39
Overview..............................................................................................................40
Performing a full installation ..............................................................................40
  User account requirements for full Installations ...........................................40
  Full installation requirements .........................................................................41
  Installing the Full GeneMapper® ID-X Software ..........................................42
Performing a client installation ..........................................................................49
  User account requirements for client installations .......................................49
  Client installation requirements ......................................................................50
  Installing the Client GeneMapper® ID-X Software ........................................51
Resetting permissions for the installation ..........................................................58
## Preface

### How to use this guide

<table>
<thead>
<tr>
<th>Purpose of this guide</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>This guide</strong></td>
<td>describes the procedures for installing the GeneMapper® ID-X Software Version 1.2.</td>
</tr>
<tr>
<td></td>
<td><strong>Chapter 1, Getting Started</strong> – Provides a roadmap to help you determine the best approach for installing the GeneMapper ID-X v1.2 software on the target computer.</td>
</tr>
<tr>
<td></td>
<td><strong>Chapter 2, Installation Requirements</strong> – Contains the specifications for the computers that are targeted for a new GeneMapper ID-X v1.2 software installation.</td>
</tr>
<tr>
<td></td>
<td><strong>Chapter 3, Performing GeneMapper® ID-X v1.2 Pre-Installation Procedures</strong> – Provides procedures on backing up and exporting application data and objects, and on uninstalling GeneMapper® ID Software Version 3.x.</td>
</tr>
<tr>
<td></td>
<td><strong>Chapter 4, Performing a New Software Installation</strong> – Provides procedures for installing a new version of the full or client software (replacing GeneMapper ID v3.x or as a new installation) on a Data Collection or non-Data Collection computer.</td>
</tr>
<tr>
<td></td>
<td><strong>Chapter 5, Performing an Upgrade</strong> – Provides procedures for installing the full or client software on a Data Collection or non-Data Collection computer currently running GeneMapper ID-X v1.0/1.0.1/1.1.1.</td>
</tr>
<tr>
<td></td>
<td><strong>Chapter 6, Performing Post-Installation Procedures</strong> – Describes the basic functions of registering the software, logging into and out of the computer, and general information following an installation.</td>
</tr>
<tr>
<td></td>
<td><strong>Chapter 7, Setting Up Autoanalysis</strong> – Describes how to set up your system to perform automatic local analysis of .fsa or .hid sample files generated on the Data Collection computer.</td>
</tr>
</tbody>
</table>
Preface

How to use this guide

- **Appendix A, Installing the Generic Updater Software** – Provides the procedure for installing the Generic Updater Software.
- **Appendix B, Troubleshooting the Installation** – Provides possible avenues for troubleshooting and resolving software installation problems.
- **Appendix C, Glossary of Terms** – Defines the terms commonly used throughout the installation guide.

**Note:** For instructions on configuring the administrative features of the software, see the *GeneMapper® ID-X Software v1.0 Administrator’s Guide*. For instructions on configuring the software to prepare for analysis, see the *GeneMapper® ID-X Software v1.0 Getting Started Guide* and the *GeneMapper® ID-X Software Online Help*.

**Audience**

This guide is written for laboratory personnel responsible for installing the GeneMapper ID-X Software v1.2.

**Assumptions**

This guide assumes that you have a working knowledge of the Microsoft® Windows® operating system.

**Text conventions**

This guide uses the following conventions:

- **Bold** indicates user action. For example:
  
  Enter 0, then press **Enter** for each of the remaining fields.

- **Italic** text indicates new or important words and is also used for emphasis. For example:

  Before analyzing, *always* prepare fresh matrix.

- A right arrow bracket ( › ) separates successive commands you select from a drop-down or shortcut menu. For example:

  Select **File › Open › Spot Set.**

  Right-click the sample row, then select **View Filter › View All Runs.**

GeneMapper® ID-X Software v1.2 Installation Guide
User attention words

Two user attention words appear in Applied Biosystems user documentation. Each word implies a particular level of observation or action as described below.

**Note:** Provides information that may be of interest or help but is not critical to the use of the product.

**IMPORTANT!** Provides information that is necessary for proper instrument operation, accurate chemistry kit use, or safe use of a chemical.

Examples of the user attention words appear below:

**Note:** The size of the column affects the run time.

**Note:** The Calibrate function is also available in the Control Console.

**IMPORTANT!** Make certain that you uninstall the GeneMapper® ID v3.2 software before you install the GeneMapper ID-X v1.2 software on the target computer.

**IMPORTANT!** You must create a separate Sample Entry Spreadsheet for each 96-well plate.
How to obtain support

For HID support send an e-mail to: HIDTechSupport@appliedbiosystems.com, or call (from within North America only) 888.821.4443 and select option 1. For support outside North America and internationally, please contact your local support office or visit the Applied Biosystems support page to obtain contact information.

For the latest services and support information for all locations, go to http://www.appliedbiosystems.com, then click Support. At the Support page, you can:

- Access worldwide telephone and fax numbers to contact Applied Biosystems Technical Support and Sales facilities.
- Search through frequently asked questions (FAQs).
- Submit a question directly to Technical Support.
- Order Applied Biosystems user documents, MSDSs, certificates of analysis, and other related documents.
- Download PDF documents.
- Obtain information about customer training.
- Download software updates and patches.
This chapter covers:

- Start here: Getting the most out of this guide ............... 2
- Installation options .............................................. 3
Chapter 1 Getting Started
Start here: Getting the most out of this guide

Start here: Getting the most out of this guide

Installation guide overview
This chapter presents an overview of the installation options available for GeneMapper® ID-X software Version 1.2. To benefit from this guide, you need to be familiar with your current computer and GeneMapper® ID Software v.3.1 or v3.2 setup (if applicable).

To get started:

1. Read through Chapter 1 to become familiar with your installation options.
2. See Chapter 2 for general installation requirements.
3. See Chapter 3 for pre-installation instructions.
4. See Chapter 4 for full installation instructions.
5. See Chapter 5 for client installation instructions.
7. See Chapter 7 for autoanalysis setup instructions.
8. See Appendix A, Installing the Generic Updater Software for generic updater installation instructions.
9. See Appendix B, Troubleshooting the Installation for troubleshooting instructions.
10. See Appendix C, Glossary of Terms, for a definition of terms used frequently in this manual.

After you have read the applicable chapters in this guide and are installing your software, refer to the GeneMapper® ID-X software Administrator’s Guide for information on configuring the GeneMapper® ID-X software administrative features and electronic data chain of custody systems.
Installation options

Installation options for the GeneMapper® ID-X software are based on the type of computer you use, the GeneMapper® ID or GeneMapper® ID-X software currently installed, and your database-sharing requirements.

If your computer has GeneMapper ID-X v1.0/1.0.1/1.1/1.1.1 installed, you can upgrade to GeneMapper ID-X v1.2. Refer to Chapter 5, “Performing an Upgrade.”

You can either install a full version of the software, which consists of both the GeneMapper ID-X software and the database, or you can install a client version of the software, which consists only of the GeneMapper ID-X software. The full version on a computer can function as the database host for the client. Multiple clients can connect to the same database through a network connection for easy data sharing.

The following table provides information on the different types of installations and where to locate the corresponding information in this guide. It also provides the different Data Collection (DC) and non-Data Collection (non-DC) computer options for autoanalysis (AA).

**Note:** If your computer has GeneMapper ID software installed, make certain that you upgrade all client and full software versions from GeneMapper ID Software v3.1 to v3.2.x before you perform a v1.2 installation.
### Table 1: Installation options summary

<table>
<thead>
<tr>
<th>Install Type</th>
<th>Install Scenarios for DC/Non-DC Computers</th>
<th>Install Description</th>
<th>Approx Time Req’d</th>
<th>31xx‡ AA</th>
<th>3730‡ AA</th>
<th>310‡ AA</th>
<th>3500‡ AA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full install (page 40)</td>
<td>New Full GeneMapper® ID-X v1.2</td>
<td>Non-DC (stand-alone) • A computer without any GeneMapper ID or GeneMapper ID-X installed or Data Collection Software installed. • Insert the CD and follow the instructions to install. • Need registration code provided with the software before using the software.</td>
<td>1 hour</td>
<td>Remote</td>
<td>Remote</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>DC Co-install</td>
<td></td>
<td></td>
<td>15 min.</td>
<td>Local</td>
<td>Local</td>
<td>NA</td>
<td>Local</td>
</tr>
<tr>
<td>Install Type</td>
<td>Install Scenarios for DC/Non-DC Computers</td>
<td>Install Description</td>
<td>Approx Time Req’d</td>
<td>31xx‡ AA</td>
<td>3730‡ AA</td>
<td>310‡ AA</td>
<td>3500‡ AA</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------</td>
<td>---------------------</td>
<td>-------------------</td>
<td>----------</td>
<td>----------</td>
<td>---------</td>
<td>---------</td>
</tr>
</tbody>
</table>
| In§ place of GeneMapper® ID v3.2 | Non-DC (stand-alone) | • A computer with only GeneMapper ID v3.2 installed.  
• Insert the GeneMapper ID-X v1.2 Full Install CD  
• Installation stops when installer detects GeneMapper ID v3.2.  
• Manually export GeneMapper ID v3.2 data using the Export Utility on the GeneMapper ID-X v1.2 Full Install CD (Disk 1)  
• Manually uninstall GeneMapper ID v3.2.  
• Install the full GeneMapper ID-X v1.2 and follow the instructions.  
• Need registration code provided with the software. | 1 hour | Remote | Remote | NA | NA |
<p>| DC Co-install | DC Co-install | Launch Data Collection Software, then perform the same procedure as the standalone installation. | 15 min. | Local | Local | NA | Local |</p>
<table>
<thead>
<tr>
<th>Install Type</th>
<th>Install Scenarios for DC/Non-DC Computers</th>
<th>Install Description</th>
<th>Approx Time Req'd</th>
<th>31xx‡ AA</th>
<th>3730‡ AA</th>
<th>310‡ AA</th>
<th>3500‡ AA</th>
</tr>
</thead>
</table>
| Client install (page 49) | New Client GeneMapper® ID-X v1.2 | - A computer without any GeneMapper ID or GeneMapper ID-X installed or Data Collection Software installed.  
- Insert the CD and follow the instructions to install.  
- Need registration code provided with the software. | 15 min. | Remote | Remote | NA | NA |
| | DC Co-install | - A computer with Data Collection Software installed.  
- Insert the CD and follow the instructions to install.  
- Need registration code provided with the software. | 15 min. | Local | Local | NA | Local |
| | In place of GeneMapper® ID v3.2 | - A computer with GeneMapper ID v3.2 installed.  
- Insert a GeneMapper ID-X v1.2 client version installation CD  
- Installation stops when installer detects GeneMapper ID v3.2.  
- Manually export GeneMapper ID v3.2 data using the Export Utility on the GeneMapper ID-X v1.2 Full Install CD (Disk 1)  
- Manually uninstall GeneMapper ID v3.2.  
- Install the GeneMapper ID-X v1.2 Client version.  
- Need registration code provided with the software. | 15 min. | Remote | Remote | NA | NA |
<table>
<thead>
<tr>
<th>Install Type</th>
<th>Install Scenarios for DC/Non-DC Computers</th>
<th>Install Description</th>
<th>Approx Time Req’d</th>
<th>31xx‡ AA</th>
<th>3730‡ AA</th>
<th>310‡ AA</th>
<th>3500‡ AA</th>
</tr>
</thead>
</table>
| Client§ Install (cont’d) (page 49) | In place§ of GeneMapper® ID v3.2 DC Co-install | • A computer with GeneMapper ID v3.2 and Data Collection Software installed.  
• Insert a GeneMapper ID-X v1.2 client install CD  
• Installation stops when installer detects GeneMapper ID v3.2.  
• Manually export GeneMapper ID v3.2 data using the Export Utility on the GeneMapper ID-X v1.2 Full Install CD (Disk 1)  
• Manually uninstall GeneMapper ID v3.2.  
• Install the GeneMapper ID-X client version 1.2.  
• Need registration code provided with the software. | 15 min. Local Local NA Local |

15 min. Local Local NA Local
<table>
<thead>
<tr>
<th>Install Type</th>
<th>Install Scenarios for DC/Non-DC Computers</th>
<th>Install Description</th>
<th>Approx Time Req’d</th>
<th>31xx² AA</th>
<th>3730² AA</th>
<th>310² AA</th>
<th>3500² AA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upgrade to Full GeneMapper® ID-X v1.2 (page 62)</td>
<td>Non-DC (stand-alone)</td>
<td>• A computer with the full GeneMapper ID-X v1.0, v1.0.1, v1.1, or v1.1.1 installed.</td>
<td>1 hour</td>
<td>Remote</td>
<td>Remote</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Insert Full GMID-X v1.2 Upgrade CD, manually export data objects (projects, analysis methods, etc.)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Uninstall the old GeneMapper ID-X version.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Install the GeneMapper ID-X v1.2.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Use the registration code from previous version to launch the software.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DC Co-install</td>
<td>• Computer with full GeneMapper ID-X v1.0, v1.0.1, v1.1, or v1.1.1 installed.</td>
<td>15 min.</td>
<td>Local</td>
<td>Local</td>
<td>NA</td>
<td>Local</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Insert the Full GMID-X v1.2 Upgrade CD.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Software detects the previous version and automatically upgrades.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Install Type</td>
<td>Install Scenarios for DC/Non-DC Computers</td>
<td>Install Description</td>
<td>Approx Time Req’d</td>
<td>31xx AA</td>
<td>3730 AA</td>
<td>310 AA</td>
<td>3500 AA</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------</td>
<td>---------------------</td>
<td>------------------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
<td>---------</td>
</tr>
</tbody>
</table>
| Upgrade to Client GeneMapper® ID-X v1.2 (page 63) | Non-DC (stand-alone) | - A computer with GeneMapper ID-X v1.0, v1.0.1, v1.1, or v1.1.1 Client installed.  
- Insert the Client GMID-X v1.2 Upgrade CD.  
- Software detects the previous version and automatically upgrades.  
- Use the registration code from previous version to launch the software. | 1 hour | Remote | Remote | NA | NA |
| | DC Co-install | - A computer with GeneMapper ID-X v1.0, v1.0.1, v1.1, or v1.1.1 Client and Data Collection Software installed.  
- Insert the Client GMID-X v1.2 Upgrade CD.  
- Software detects the previous version and automatically upgrades. | 15 min. | Local | Local | NA | Local |

‡ Remote autoanalysis (AA) is only available if you are using 31xx and 3730 Data Collection (DC) computers. Local autoanalysis is only available if you are using 31xx, 3730 and 3500 computers (remote AA is not available for 3500 DC computers). Remote autoanalysis and local autoanalysis are not available for 310 computers.

§ If GeneMapper ID v3.1 is installed, you must upgrade to GeneMapper ID v3.2 before installing GeneMapper ID-X v1.2.

# To use a client version of the software, a full GeneMapper ID-X program must be installed on another computer.
See Figure 1 to determine the steps to take based on the desired installation configuration from GeneMapper® ID v3.2.x.

**GeneMapper® ID Software v3.2.x options**

Is the GeneMapper® ID Software v3.2.x installed on the computer?

- **NO**
  - Perform a new full or client installation

- **YES**
  - Export GMID v3.2.x data‡
  - Manually uninstall the GeneMapper® ID Software v3.2.x
  - Perform a full or client installation

‡ GeneMapper ID Software

**Figure 1** Possible GeneMapper® ID-X software v1.2 installation configurations from GeneMapper® ID v3.2.x.
Chapter 1  Getting Started

Installation options

See Figure 2 to determine the steps to take based on the desired installation configuration from GeneMapper® ID-X.

**GeneMapper® ID-X Software v1.0/1.0.1/1.1/1.1.1 options**

![Diagram](image-url)

Figure 2  Possible GeneMapper® ID-X software v1.2 installation configurations from GeneMapper® ID-X software v1.0/1.0.1/1.1/1.1.1.
Installation Requirements

This chapter covers:

- Installation CDs .............................................. 14
- Full installation computer requirements ................. 16
- Client installation computer requirements ............... 18
- Verifying your computer setup ............................. 19
- Analyzers and compatible software ....................... 20
Installation CDs

Four different installation CDs are available:

- **New full installation (with registration code)** – The two *GeneMapper® ID-X Software Version 1.2 Full Install CDs* (Disks 1 and 2) install the full version (GeneMapper ID-X Software and multi-user database) on the target computer. The full version CDs also include extra Generic Updater Software and an installation Export Utility. If your computer has GeneMapper ID v3.x installed, you will need to uninstall the GeneMapper ID v3.x software before installing GeneMapper ID-X v1.2. You can install the software on any compatible computer, but Applied Biosystems does not recommend using a computer that has the GeneMapper ID-X Full version co-installed with a data collection software as the host computer that connects to multiple GeneMapper ID-X Client computers.

- **Client installation (with registration code)** – The *GeneMapper® ID-X Software Version 1.2 Client Install CD* installs the client GeneMapper ID-X Software on the target computer. You can install the client on any compatible computer (including one running Data Collection Software) and connect to any multi-user database on the same local area network.

- **Full upgrade (existing registration code)** – The *GeneMapper® ID-X Software Version 1.2 Full Upgrade Install CD* automatically installs the full GeneMapper ID-X Software v1.2 on a Data Collection computer that has v1.0/1.0.1/1.1/1.1.1 installed. For a non-Data Collection computer and a client-to-full installation, you must uninstall v1.0/1.0.1/1.1/1.1.1 software prior to the installation. You can install the software on any target computer already running GeneMapper ID-X Software by following these guidelines. Use the registration information from the GeneMapper ID-X v1.0/1.0.1/1.1/1.1.1 to launch the GeneMapper ID-X v1.2 software.
Chapter 2 Installation Requirements

Installation CDs

- **Client upgrade (existing registration code)** – The GeneMapper® ID-X Software Version 1.2 Client Upgrade Install CD installs the client GeneMapper ID-X Software v1.2 on the target computer. To perform a full-to-client installation, you must first uninstall the full installation. You can install the software on any target computer already running GeneMapper ID-X Software v1.0/1.0.1/1.1/1.1.1.

  **Note:** If you upgrade on a client computer, you must also upgrade the computer that hosts the full multi-user database on the same local area network.

An additional GeneMapper® ID-X Software Documentation CD comes with the software. This CD includes all installation and associated GeneMapper ID-X documentation.

**Note:** The GeneMapper® ID-X Software Version 1.2 Installation Guide and supporting documentation are provided on a separate CD. To open the user documentation on the CD, you need Adobe® Acrobat® Reader® software. Download from www.adobe.com or www.appliedbiosystems.com/support/software.
Chapter 2  
Installation Requirements

Full installation computer requirements

**Minimum configurations**  
Table 2 shows the recommended and minimum computer configurations for a *new full installation* (the GeneMapper® ID-X Software v1.2 and database).

**Note:** To install the GeneMapper ID-X software, you need a local user account with administrative privileges. You can run the computer on regional settings but you need an English Operating System.

Table 2  
Computer requirements for a new full installation

<table>
<thead>
<tr>
<th>Component</th>
<th>Recommended Configuration</th>
<th>Minimum Configuration‡</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Computer</strong></td>
<td>• Intel Pentium® IV processor, &gt;2.8 GHz</td>
<td>• Intel Pentium® processor, 733 MHz</td>
</tr>
<tr>
<td></td>
<td>• Intel Pentium® processor, 733 MHz</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• 1 GB of RAM</td>
<td>• 1 GB of RAM</td>
</tr>
<tr>
<td></td>
<td>• Two 120-GB hard drives§</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Free disk space:</td>
<td>• Free disk space:</td>
</tr>
<tr>
<td></td>
<td>− 200 MB on the boot drive (drive on which the</td>
<td>− 200 MB on the boot drive (drive on which the</td>
</tr>
<tr>
<td></td>
<td>operating system is installed)</td>
<td>operating system is installed)</td>
</tr>
<tr>
<td></td>
<td>− 10 GB on the drive on which the GeneMapper</td>
<td>− 10 GB on the drive on which the GeneMapper</td>
</tr>
<tr>
<td></td>
<td>ID-X Software resides</td>
<td>ID-X Software residency</td>
</tr>
<tr>
<td></td>
<td>• 20/48X IDE CD-ROM</td>
<td>• 20/48X IDE CD-ROM</td>
</tr>
<tr>
<td></td>
<td>• 10/100 NIC with RWU (internal)</td>
<td>• 10/100 NIC with RWU (internal)</td>
</tr>
<tr>
<td><strong>Monitor</strong></td>
<td>• 1024 × 768 pixel resolution</td>
<td>• 1024 × 768 pixel resolution</td>
</tr>
<tr>
<td></td>
<td>• 19-inch color monitor</td>
<td>• 17-inch color monitor</td>
</tr>
<tr>
<td><strong>Operating System</strong></td>
<td>Windows Vista® Business (SP1), Windows XP Professional (SP2 &amp; SP3), Windows 2000 Professional (SP4)</td>
<td></td>
</tr>
<tr>
<td><strong>Ethernet Capability</strong></td>
<td>• Network card for database installation</td>
<td>• TCP/IP must be installed before database installation</td>
</tr>
</tbody>
</table>

‡ The minimum configuration may not provide optimal performance.
§ Required if the Data Collection and GeneMapper® ID-X Software are installed on the same computer.
Chapter 2  Installation Requirements

Full installation computer requirements

**Note:** GeneMapper® ID-X software is validated to run on Intel® Core™ 2 Duo processor computers.

---

### Required time for full installation

The amount of time required to perform a full installation is:

- Approximately 1 hour on a non-Data Collection computer, depending on the speed of the computer.
- Approximately 15 minutes on a Data Collection computer (340 SCSI).
- Approximately 1 hour and 15 minutes on other Data Collection computers.
Client installation computer requirements

Minimum configurations

Table 3 shows the minimum computer configurations for a client installation (GeneMapper® ID-X Software v1.2 only).

**Note:** To log in to the GeneMapper ID-X software, you need a local user account with administrative privileges. For sites outside the U.S., you may need to change regional settings to U.S. settings following software installation.

<table>
<thead>
<tr>
<th>Component</th>
<th>Minimum Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Computer</td>
<td>• Intel Pentium® processor, 733 MHz</td>
</tr>
<tr>
<td></td>
<td>• 512 RAM for Microsoft® Windows XP or 2000; 1 GB for Microsoft® Windows Vista® ‡</td>
</tr>
<tr>
<td></td>
<td>• 20/48X IDE CD-ROM drive</td>
</tr>
<tr>
<td></td>
<td>• 10/100 NIC with RWU (internal)</td>
</tr>
<tr>
<td></td>
<td>• 250 MB of free disk space</td>
</tr>
<tr>
<td></td>
<td>• 200 MB on the boot drive (drive on which the operating system is installed)</td>
</tr>
<tr>
<td>Monitor</td>
<td>• 1024 × 768 pixel resolution</td>
</tr>
<tr>
<td></td>
<td>• 17-inch color monitor (smaller monitor lessens ability to view a full screen of data)</td>
</tr>
<tr>
<td>Operating System</td>
<td>Windows Vista® Business (SP1), Windows XP Professional (SP2 &amp; SP3), Windows 2000 Professional (SP4)</td>
</tr>
</tbody>
</table>

‡ Although you can install the GeneMapper ID-X Software on a computer with 512 MB of RAM, Applied Biosystems recommends using 1 GB or more of RAM for better performance.

Required time for client Installation

The amount of time required to perform a client installation is approximately 15 minutes.

Optimizing computer performance

For recommendations on the number of client connections to use per host to optimize computer performance, contact Applied Biosystems.
Verifying your computer setup

1. On the desktop, right-click My Computer, then select Properties.

2. Click the General tab of the System Properties dialog box to verify that your computer meets the minimum requirements for installation.
Analyzers and compatible software

Instrumentation  
Table 4 lists Applied Biosystems Genetic Analyzer instruments and the corresponding Data Collection and operating system software that are supported by the GeneMapper® ID-X Software.

<table>
<thead>
<tr>
<th>Genetic Analysis Instrument</th>
<th>Data Collection Software and Operating System</th>
</tr>
</thead>
</table>
| Applied Biosystems 3500 Series Genetic Analyzer | • 3500 Data Collection v1.0  
• Windows Vista SP 1 |
| ABI PRISM® 310 Genetic Analyzer | • 310 Data Collection v3.0 or v3.1  
• Windows XP SP 2 or later |
| Applied Biosystems 3130/3130xl Genetic Analyzer | • 3130 Data Collection v3.0/3130xl Data Collection v3.0  
• Windows XP SP 2 or later |
| ABI PRISM® 3100/3100-Avant™ Genetic Analyzer | • 3100 Data Collection v2.0/3100-Avant™ Data Collection v2.0  
• Windows 2000 SP 4 or later and Windows XP SP 2 or later |
| Applied Biosystems 3730 Genetic Analyzer† | • 3730 Data Collection v3.0  
• Windows XP SP 2 or later |

† The 3730 Genetic Analyzer does not include the 3730xl 96-capillary configuration. The 48-capillary configuration is validated for analysis of data generated from Identifiler® kits using single-source samples only.
Chapter 3

Performing GeneMapper®
ID-X v1.2 Pre-Installation Procedures

This chapter covers:

- Overview .................................................. 22
- Requirements for upgrading GeneMapper® ID v3.1 to
  GeneMapper® ID v3.2 ......................................... 24
- Exporting GeneMapper® ID v3.2.x data ...................... 24
- Uninstalling the GeneMapper ID v3.2 and GeneMapper ID-X
  v1.0/1.0.1/1.1/1.1.1 software .......................... 28
- Enabling autoanalysis ..................................... 31
- Obtaining the GeneMapper® ID-X Software host
  computer name ........................................... 37
Overview

Reminders
This chapter provides procedures that you must perform to install GeneMapper® ID-X Software v1.2 on computers that have GeneMapper® ID Software v3.x or GeneMapper® ID-X Software v1.0/1.0.1/1.1/1.1.1 currently installed.

IMPORTANT! If you are installing GeneMapper ID-X v1.2 software on a computer without GeneMapper ID v3.x or GeneMapper ID v1.0/1.0.1/1.1/1.1.1, proceed to Chapter 4 for full or client installation instructions.

IMPORTANT! If you are upgrading to GeneMapper ID-X v1.2 from GeneMapper ID v3.x or GeneMapper ID-X v1.0/1.0.1/1.1/1.1.1, go to Chapter 5.

Before installing GeneMapper ID-X software on computers that have GeneMapper ID v3.x software installed, you must export the data objects (projects, analysis methods, etc.) as a means of backing up the data, then uninstall the existing software. Because data objects are deleted when GeneMapper ID 3.x is uninstalled, if they are not exported and saved to a different location, they cannot be restored.

The GeneMapper® ID-X Software Version 1.2 Full Install CD contains a GeneMapper ID v3.2.x Software Export Utility, which automatically exports all data objects stored within your GeneMapper ID v3.2.x database and stores the files in a user-defined location. This utility is only designed to work in conjunction with GeneMapper ID v3.2 and above. Therefore, if you are still running GeneMapper ID v3.1 software, upgrade to GeneMapper ID v3.2 to take advantage of this export utility (see “Requirements for upgrading GeneMapper® ID v3.1 to GeneMapper® ID v3.2” on page 24).
Upgrade to GeneMapper ID v3.2 if you also wish to import the exported files into GeneMapper ID-X v1.2 once the software is installed, and if you plan to install the full version of GeneMapper ID-X v1.2 on a 3500 Data Collection computer.

**Note:** GeneMapper ID v3.2.x data objects may be imported and viewed in GeneMapper ID-X v1.2; however, their use is limited. (See “Optimizing data sharing” on page 103).
Requirements for upgrading GeneMapper® ID v3.1 to GeneMapper® ID v3.2

To upgrade from GeneMapper ID v3.1 to GeneMapper ID v3.2, you must have a GeneMapper® ID Software v3.2 Installation CD and a valid GeneMapper ID v3.1 registration code. If you do not have one or both of these items, please contact your local technical support organization.

Exporting GeneMapper® ID v3.2.x data

To export data, you can use the Export Utility to automatically export all data objects from the GeneMapper Manager and Panel Manager within the GeneMapper® ID Software v3.2.x application. Alternatively, you can export each data object manually.

Applied Biosystems recommends that you use the Export Utility to more efficiently export data. Once the data is exported and saved to a new location, archive these objects using your lab’s standard procedure.

IMPORTANT! You can only export data using the Export Utility when upgrading from GeneMapper ID v3.2.x. When upgrading from GeneMapper ID-X v1.0/1.0.1/1.1.1 to v1.2, you must export GeneMapper ID-X data manually. See “Manually exporting GeneMapper ID v3.2 or GeneMapper ID-X v1.0/1.0.1/1.1.1 data objects” on page 26.
Using the export utility (GeneMapper® ID v3.2.x software only)

1. Insert the GeneMapper® ID-X Software Version 1.2 Full Install CD into the CD drive.
2. On the splash screen, click Export Data from GeneMapper ID v3.2 or 3.2.1.

Note: If there is no GeneMapper ID v3.2 on the target system, the export button is disabled.
3. When the Export tool window is displayed, click **Browse** to specify the location to save all exported files, or enter a destination folder in the field provided:

![GeneMapper ID 3.2x Export Tool](image)

**IMPORTANT!** Choose an export location outside the **Applied Biosystems → GeneMapper** application folder. The GeneMapper folder is deleted when GeneMapper ID v3.x is uninstalled.

4. Click **Export**.
   - If the utility detects a conflict with the location specified, an error message is displayed. Follow the instructions given in the error messages before proceeding. These error messages include:
     - No destination is specified for export files. Please select a destination.
     - Specified location does not exist. Please select a new location.
     - Access to specified location denied. Please check folder permissions or select a new location.
     - You have chosen to export data to the **Applied Biosystems → GeneMapper** application folder. This folder is deleted when GeneMapper ID 3.2 is uninstalled. Select a location outside of the **Applied Biosystems → GeneMapper** application folder.
Chapter 3  Performing GeneMapper® ID-X v1.2 Pre-Installation Procedures

Exporting GeneMapper® ID v3.2.x data

• If the export is successful the following message is displayed:

  ![Export Complete](image1)

  All-GMD 3.2 projects and analysis files were successfully exported to <C:/Documents and Settings/jean/1/Desktop>

  If you wish to install GMD-X to this computer, you must first manually uninstall GMD 3.2 software.

  Uninstallation of GMD 3.2 software must be performed through Add/Remove Program found in the Control Panel.

  Please perform GMD-X new installation after this step.

  OK

• If the export is only partially successful, the following message is displayed:

  ![Export Errors](image2)

  One or more data objects failed to export to <C:\app\gene\app\data\system>. Would you like to view the log file for details?

  Yes  No

  Proceed to the log file and manually export all data objects that failed to export.

5. After you have exported all your files, proceed to “Uninstalling the GeneMapper ID v3.2 and GeneMapper ID-X v1.0/1.0.1/1.1/1.1.1 software” on page 28.
Uninstalling the GeneMapper ID v3.2 and GeneMapper ID-X v1.0/1.0.1/1.1/1.1.1 software

IMPORTANT! You must restart your computer before uninstalling. If you forget to do so, upon running the uninstall, the computer prompts you to restart your computer (click Cancel to exit the uninstall). If you have already restarted your computer, click OK to continue the uninstall.

IMPORTANT! If you intend to install the full or client GeneMapper ID-X v1.2 software on a computer running GeneMapper ID v3.2 software or GeneMapper ID-X V1.0/1.0.1/1.1/1.1.1 software, you must uninstall your existing software, then install GeneMapper ID-X v1.2.

If you intend to upgrade to the full GeneMapper ID-X v1.2 software on a computer running a previous version of the full GeneMapper ID-X software (stand alone), you must uninstall your existing software, then install GeneMapper ID-X v1.2. If you are upgrading a previous version of the client GeneMapper ID-X software on a client computer, or upgrading a GeneMapper ID-X full version that is co-installed with Data Collection Software, there is no need to uninstall the software; the software will automatically upgrade to v1.2.

Follow the steps below to uninstall GeneMapper ID Software v3.2 and GeneMapper ID-X Software v1.0/1.0.1/1.1/1.1.1:

1. Log in to the computer using a user account with administrative privileges.
2. Close the GeneMapper® ID Software v3.2 or GeneMapper® ID-X Software v1.0/1.0.1/1.1/1.1.1 and all other applications, then restart your computer before proceeding with the uninstall.

**IMPORTANT!** If you do not restart your computer before proceeding with the uninstall and/or if the uninstall does not complete successfully the first time, perform this procedure a second time. If the uninstall still does not work, have a knowledgeable technician review and proceed with “Running the clean-up utility” on page 128 or contact Applied Biosystems Technical Support to proceed.

3. Select **Start** ➤ **Control Panel**.

4. Double-click **Add or Remove Programs**.

**Note:** If a message indicates that you need administrator rights or privileges, log off the computer, then log on again as a user with administrator privileges.

5. Select **GeneMapper® ID Software** or **GeneMapper® ID-X Software**.

6. Click **Change/Remove**. The InstallShield Wizard opens.

7. In the Welcome page, select **Remove**, then click **Next**.

8. At the prompt, click **OK** to verify the uninstall.
9. When the Maintenance Complete window opens, select **Yes, I want to restart my computer now.**

**IMPORTANT!** For the uninstallation to complete, you must restart the computer. *Do not install* GeneMapper® ID-X v1.2 software without first restarting your computer.

**IMPORTANT!** After you restart your computer, a command prompt window may be displayed. This window can take up to 40 seconds to close. *Do not close* this window. Wait for the process to complete on its own. If you close the window, the GeneMapper® ID-X software may not install correctly.
Enabling autoanalysis

Use autoanalysis if you want to communicate with the Data Collection Software for the collection and processing of .fsa and .hid sample files, and for data analysis.

For installations in which you want autoanalysis enabled, follow the procedures below:

- Start the Data Collection Software to enable autoanalysis during the full and client installation procedures (see page 32).
- Retrieve the Data Collection computer name to enable autoanalysis during the full and client installation procedure (see page 35).
- Retrieve the Host Computer name to enable client access to the host computer during the client installation procedure (see page 37).

**IMPORTANT!** The Data Collection Software must be running during installation if you wish to run autoanalysis.

**IMPORTANT!** Remote autoanalysis is only accessible from 31xx and 3730 Data Collection (DC) computers, not from 3500 DC computers. However, if you are using 31xx, 3730 and 3500 computers for co-installed applications, you can perform local autoanalysis.
Starting the Data Collection Software on the Data Collection computer

**Starting the Data Collection Software to enable autoanalysis**

Start the Data Collection Software on the 31xx or 3730 Data Collection computer before installing the full GeneMapper® ID-X Software v1.2 on your computer for a remote autoanalysis configuration, or on the 31xx, 3730 or 3500 Data Collection computer for a co-installation.

**Note:** For 310 Data Collection computers only: The following Data Collection Software sections are not applicable. Proceed to “Performing a full installation” on page 40 or “Performing a client installation” on page 49.

**Starting the Data Collection Software on 31XX and 3730 computers**

Use the following procedure to enable autoanalysis only.

1. On the 31xx or 3730 Data Collection computer, select Start ➤ All Programs ➤ Applied Biosystems ➤ Data Collection ➤ Run <Data Collection version>, where <Data Collection version> is:
   - 3100/3100-Avant™ Data Collection v2.0,
   - or
   - 3130/3130xI Data Collection v3.0.

2. After the Service Console opens, wait until all four symbols change to green squares.
Chapter 3 Performing GeneMapper® ID-X v1.2 Pre-Installation Procedures

Enabling autoanalysis

Note: If the software services do not start automatically, click Start All.

3. If the Data Collection Software requires a password, a login dialog box opens. Enter the Login Name and Password, then click OK.

Note: If you do not know the Data Collection computer Login Name or Password, contact your Data Collection computer administrator.

4. Verify that the Data Collection Software started without errors:
   a. In the Service Console, right-click the square beside Data Service, then select Show Console to display the Data Service output message box.
Enabling autoanalysis

b. Verify that no errors are displayed in the lower pane of the message box, then close the Data Service output message box.

Starting the Data Collection Software on the 3500 computer

Use the following procedure to enable autoanalysis only.

1. Select Start ▶ Programs ▶ Applied Biosystems ▶ 3500 ▶ Daemon.

   **Note:** It will take approximately 15 seconds for Daemon to populate.

2. If the Server Monitor does not start automatically, select Start ▶ Programs ▶ Applied Biosystems ▶ 3500 ▶ Server Monitor.

   It will take approximately 2 minutes for the Server Monitor to set up. During this time, you will see the status icon transition from a red circle, with an × in the middle (indicating that not all 3500 services are loaded), to the shape of an hour-glass on your desktop, in the toolbar at the bottom of your desktop.

   When Server Monitor setup is complete, the icon in the shape of an hour-glass disappears and a checkmark icon appears, indicating that the 3500 Server Monitor started and all 3500 services loaded.
3. Launch the application. Select: **Start ➤ Programs ➤ Applied Biosystems ➤ 3500.**

The 3500 Series Data Collection Software splash screen appears, followed by the Dashboard and Log In dialog box.

4. When the Data Collection Software splash screen disappears, log in from the Dashboard by entering the User Name and Password, then click **OK.**

**Note:** If you do not know the Data Collection computer User Name or Password, contact your Data Collection computer administrator.

The 3500 Series Data Collection Software splash screen re-appears. This screen remains active for a few seconds while the 3500 Series Data Collection Software launches and the Dashboard appears.

**Obtaining the Data Collection computer name**

If you are installing the client GeneMapper® ID-X Software v1.2 on a non-Data Collection computer to enable remote autoanalysis, you must first obtain the name of the 31xx or 3730 Data Collection computer:

1. On the 31xx or 3730 Data Collection computer, right-click **My Computer**, select **Properties**, then select the **Computer Name** tab to view the full computer name.
2. Make a note of the computer name and enter this name when prompted during installation of the client GeneMapper® ID-X Software.
Chapter 3 Performing GeneMapper® ID-X v1.2 Pre-Installation Procedures

Obtaining the GeneMapper® ID-X Software host computer name

Before you install the client GeneMapper® ID-X Software, obtain the name of the multi-user database host computer to enable access to the host computer from a network:

1. On the multiuser database host computer, right-click My Computer, select Properties, then select the Computer Name tab.

2. Make a note of the computer name and enter this name when prompted during installation of the client GeneMapper® ID-X Software.
Chapter 3 Performing GeneMapper® ID-X v1.2 Pre-Installation Procedures

Obtaining the GeneMapper® ID-X Software host computer name
Chapter 4

Performing a New Software Installation

This chapter covers:

- Overview ................................................................. 40
- Performing a full installation ....................................... 40
- Performing a client installation ................................. 49
Overview

This chapter describes how to perform a new full or client installation of the GeneMapper® ID-X Software Version 1.2 on your target computer.

**Note:** If you have GeneMapper® ID Software v3.x or GeneMapper® ID-X Software v1.0/1.0.1/1.1/1.1.1 on your computer and haven’t already performed pre-installation tasks, go back to Chapter 3, “Performing GeneMapper® ID-X v1.2 Pre-Installation Procedures,” on page 21 for additional instructions. The installation may fail if these tasks are not performed first.

Performing a full installation

A full GeneMapper® ID-X Software v1.2 installation:

- Installs the GeneMapper ID-X software and database.
- Enables the GeneMapper ID-X v1.2 software to serve as the host for multiple client computers needing access to the database.

**Note:** It is not recommended that the Data Collection computer function as the host computer due to performance constraints.

User account requirements for full Installations

**Log on requirements**

To perform a new full installation of GeneMapper ID-X v1.2, you must:

- Log on to the local computer (not a network domain).
- Use an Administrator account (unrestricted access).

**Note:** After the software is installed, you can run the GeneMapper ID-X v1.2 without using an Administrator account.
Verifying user accounts

1. On the desktop, select Start ▶ Control Panel.
2. In the Control Panel window, double-click User Accounts.
3. In the Users tab, verify that the user account belongs to the Administrators group and the domain name is the same as the computer name.

Full installation requirements

**Important reminders**

Below is a list of items to take into consideration prior to installing GeneMapper ID-X v1.2.

- *DO NOT* cancel an installation before the installation process is finished. If you do so, or if the installation otherwise stalls, you may need technical support to perform an uninstall. To uninstall your installation, see “Uninstalling the GeneMapper® ID-X Software” on page 126. If uninstallation fails, contact your local Applied Biosystems technical support organization.
• In a co-installation (Data Collection computer with Data Collection Software), you are limited to one client connection. To allow more client connections to the database, install the full version GeneMapper® ID-X Software (software and database) on a computer other than the Data Collection (DC) computer.

• When installing GeneMapper ID-X v1.2 on a 31xx or 3730 DC Computer that has GeneMapper ID v3.2 software, you do not need to uninstall the v3.2 software; however, you must recreate all the files associated with autoanalysis (e.g. Results Groups) because old files created as part of the GeneMapper ID v3.2 integration cannot be reused. See Chapter 7, “Setting Up Autoanalysis.”

• When you install GeneMapper ID-X v1.2 on a 31xx or 3730 DC computer as a co-installation, or on a non-DC computer and you intend to access the DC computer for remote autoanalysis, the Data Collection Software must be running on the DC Computer. For more information on starting the Data Collection Software, see page 32.

Note: If you install the GeneMapper ID-X v1.2 software on the 3500 DC computer (co-installation), you will be able use the 3500 computer to perform local autoanalysis. However, if you install the GeneMapper ID-X v1.2 software on a non-DC computer, you will not be able to access the 3500 computer to perform remote autoanalysis.

• To set up remote autoanalysis, obtain the computer name of the DC Computer: Right-click My Computer on the DC computer, select Properties, then select the Computer Name tab to view and record the full computer name. You are required to enter this during installation (see page 35).

Installing the Full GeneMapper® ID-X Software

To install the Full GeneMapper® ID-X Software v1.2 onto your computer:

1. Insert the first disk of the GeneMapper® ID-X Software Version 1.2 Full Install CDs into the CD drive (if not inserted during use of the Export Utility).
2. On the splash screen, double-click **Install GeneMapper ID-X v1.2 Application** to start the installer.

   **Note:** If you install on a DC or non-DC computer running GeneMapper ID v3.2, you will be prompted to insert the full GeneMapper ID-X v1.2 to export data objects. When you are done, uninstall the GeneMapper ID v3.2, then continue with the GeneMapper ID-X v1.2 installation. For additional information on exporting data objects, see “Exporting GeneMapper ID v3.2.x data with utility tool” on page 25.

3. Close all other applications and windows (except the Data Collection application), then click **OK** to close the following message.

   ![GeneMapper® ID-X v1.2](image)

   **Close all running applications before proceeding with the installation.**

   **OK**

4. In the Welcome window, click **Next**.

5. Review the installation requirements status, then click **Next**.
6. Select **Remote Autoanalysis** or **Stand-alone** for type of installation, then click **Next**:

- **Remote Autoanalysis** – Select this option to set up remote autoanalysis. In this configuration, the target computer is networked to the 31xx or 3730 DC computer. The autoanalysis manager alerts GeneMapper ID-X when a run is complete. GeneMapper ID-X then opens, and you can import the .fsa files into a project and analyze them.

  **Note:** If you install the GeneMapper ID-X v1.2 software on a non-DC computer, you will not be able to access the 3500 computer to perform remote autoanalysis. Proceed to step 9.

- **Stand-Alone** – Select this option if you do not want to set up remote autoanalysis or if your DC computer is not networked to the target computer during installation.

  **IMPORTANT!** After the GeneMapper ID-X v1.2 Software is installed, you cannot switch from stand-alone to remote autoanalysis. To change the configuration, you must uninstall, then reinstall the software.

  **Note:** For a co-installation on the 31xx, 3730 and 3500 Data Collection computers, you do not have the option of selecting stand-alone or remote autoanalysis. You can optionally set up local autoanalysis later. See “Setting up autoanalysis on the 31xx or 3730 computer” on page 81 for instructions.

  **Note:** For the 310 Data Collection computer, autoanalysis (local or remote) is not available. Proceed to step 9.

  **Note:** If you select **Stand-alone**, skip step 8 and step 14.
Chapter 4  Performing a New Software Installation

Performing a full installation

7. (Remote Autoanalysis only) Select the DC Computer that you wish to connect to, then click Next.

8. (Remote Autoanalysis only) Enter the full name of the Data Collection computer that you intend to have support remote autoanalysis (see page 35), then click Next.
9. Read the release notes, then click Next.

10. Click Next to install the Software to the default location. To install the GeneMapper® ID-X Software to a drive different from the default drive, select the destination folder:

   a. Verify that the boot drive (drive on which the Windows operating system is installed) contains at least 200 MB of available free space.

   b. Select a destination folder with at least 10 GB of free space, then click Next.

**IMPORTANT!** If you choose an invalid destination such as A: drive or CD-DVD ROM and click Next, an error message is displayed saying the drive is invalid. When you click OK the installation is stopped. To recover, click Cancel and start the installation over again, using a valid destination folder.
11. Select a Setup Type if desired: either Desktop Short Cut and/or Quick Launcher or deselect both, then click Next.
12. Read the current settings, then click **Next** to start the installation.

**IMPORTANT!** During installation, a DOS window may open while DOS commands execute. Do not delete, close, or click the DOS window. If you accidentally click the DOS window, press the **Esc** key to exit the window.

13. When prompted, insert Disk 2 and follow instructions.

14. **(Remote Autoanalysis only)** When GeneMapper® *ID-X* Software installation is complete, if you were running the Data Collection Software, stop the software on the Data Collection computer by clicking **Stop All** in the Service Console.

![Service Console](image)

15. Remove the installation CD from the CD drive.

16. In the InstallShield Wizard Complete page, select **Yes, I want to restart my computer now**, then click **Finish**.

When you finish the installation, proceed to Chapter 6, “Performing Post-Installation Procedures,” on page 65.

To set up autoanalysis after performing post-installation procedures, proceed to Chapter 7, “Setting Up Autoanalysis,” on page 73.
Performing a client installation

A client GeneMapper® ID-X Software v1.2 installation:

- Allows the user access to the GeneMapper ID-X v1.2 software without a database installed on the same computer.
- Connects to one or more database hosts for access to the data stored in the database and saves data objects back to the database.

User account requirements for client installations

Log on requirements

To perform a client installation of the GeneMapper® ID-X Software:

- Confirm that the target computer is connected to the database host computer when you log in. If there is no login window that connects you to the local area network served by the host, or if you are not automatically connected, contact your lab’s on-site technical support department.
- Use an Administrator account (unrestricted access).

Note: After the software is installed, you can run the GeneMapper® ID-X Software without using an Administrator account.

Verifying user accounts

1. On the desktop, select **Start**  ➤ **Control Panel**.

2. In the Control Panel window, double-click **User Accounts**.

3. In the Users tab, verify that the user account belongs to the Administrators group and the domain name is the same as the computer name.
Client installation requirements

**Important reminders** Below is a list of items to take into consideration before you perform a client installation:

- **DO NOT** cancel an installation before the installation process is finished. If you do so, or if the installation otherwise stalls, you may need technical support to perform an uninstall. To uninstall your installation, see “Uninstalling the GeneMapper® ID-X Software” on page 126. If uninstallation fails, contact your local Applied Biosystems technical support organization.

- At least one full installation of the same software version must be performed on another computer for it to act as the database host for the client.

- Users are required to have a valid user name and password with an account on the database host computer.
• You must obtain the name of the database host computer to enable access to the host computer from a network: Right-click My Computer on the database host computer, select Properties, then select the Computer Name tab to view and record the full computer name. You are required to enter this name during installation (see page 37).

• When you install GeneMapper ID-X v1.2 on a 31xx, 3730 or 3500 DC Computer as a co-installation, or on a 31xx or 3730 non-DC computer and you intend to access the DC computer for remote autoanalysis, the Data Collection Software must be running on the DC computer (see page 32).

Note: If you install the GeneMapper ID-X v1.2 software on the 3500 DC computer (co-installation), you will be able use the 3500 computer to perform local autoanalysis. However, if you install the GeneMapper ID-X v1.2 software on a non-DC computer, you will not be able to access the 3500 computer to perform remote autoanalysis.

• If you choose to set up remote autoanalysis, obtain the Computer Name of the Data Collection computer: Right-click My Computer on the Data Collection computer, select Properties, then select the Computer Name tab to view and record the full computer name. You are required to enter this during installation (see page 35).

Installing the Client GeneMapper® ID-X Software

To install the Client GeneMapper® ID-X Software Version 1.2 on the target computer:

1. Insert the GeneMapper® ID-X Software Version 1.2 Client Install CD into the CD drive.
2. On the splash screen, double-click **Install GeneMapper ID-X v1.2 Client** to start the installer.

   **Note:** If you install on a DC or non-DC computer with GeneMapper ID v3.2, you will be prompted to insert the full GeneMapper ID-X v1.2 to export data objects. When you are done, uninstall the GeneMapper ID v3.2, then continue with the GeneMapper ID-X v1.2 installation. For additional information on exporting data objects, see “Exporting GeneMapper ID v3.2.x data with utility tool” on page 25.

3. Be sure that the Data Collection Software application is running but close all other applications and windows, then click **OK** to close the following message.

4. In the Welcome window, click **Next**.

5. Review the installation requirements status, then click **Next**.

6. Read the release notes, then click **Next**.

7. When prompted, enter the GeneMapper® ID-X Software (GM) host (server) computer name, then click **Next**.
8. After the installer establishes a connection with the multi-user database computer, click OK to continue.
9. Select **Remote Autoanalysis** or **Stand-Alone** for type of installation, then click **Next**.

- **Remote Autoanalysis** – Select this option to set up remote autoanalysis. In this configuration, the target computer is networked to the 31xx or 3730 DC computer. The autoanalysis manager alerts GeneMapper ID-X when a run is complete. GeneMapper ID-X then opens, and you can import the .fsa files into a project and analyze them.

- **Stand-Alone** – Select this option if you do not want to set up remote autoanalysis or if your DC computer is not networked to the target computer during installation.

**IMPORTANT!** After the GeneMapper ID-X v1.0 or v1.1 Software is installed, you cannot switch from stand-alone to remote autoanalysis. To change the configuration, you must uninstall, then reinstall the software.

**Note:** For a co-install on the 31xx, 3730, and 3500 Data Collection computers, you do not have the option of selecting stand-alone or remote autoanalysis. You can optionally set up local autoanalysis later. See “Setting up autoanalysis on the 31xx or 3730 computer” on page 81 for instructions.

**Note:** For the 310 Data Collection computer, autoanalysis (local or remote) is not available. Proceed to step 12.

**Note:** If you select **Stand-alone**, skip step 11 and step 14.
10. *(Remote Autoanalysis only)* Select the DC Computer that you wish to connect to, then click **Next**.

11. *(Remote Autoanalysis only)* Enter the full name of the Data Collection computer that will support the remote autoanalysis configuration, then click **Next**.
12. To install the GeneMapper® ID-X Software to a drive on the client computer other than the default drive, select the destination folder and verify that the boot drive (drive on which the Windows operating system is installed) contains at least 250 MB of available free space.

**IMPORTANT!** If you choose an invalid destination such as A: drive or CD-DVD ROM and click Next, an error message is displayed saying the drive is invalid. When you click OK the installation is stopped. To recover, click Cancel and start the installation over again, using a valid destination folder.
Chapter 4 Performing a New Software Installation

Performing a client installation

13. Read the current settings, then click Next to start the installation.

   IMPORTANT! During installation, a DOS window may open while DOS commands execute. Do not delete, close, or click the DOS window. If you accidentally click the DOS window, press the Esc key to exit the window.

14. When installation of the GeneMapper® ID-X Software is complete, if you were running the Data Collection Software, stop the software on the Data Collection computer by clicking Stop All in the Service Console.

15. Remove the installation CD from the CD drive.

16. In the InstallShield Wizard Complete window, select Yes, I want to restart my computer now, then click Finish.

17. Repeat the procedure for additional client installations.

   When you finish all client installations, proceed to Chapter 6, “Performing Post-Installation Procedures,” on page 65.

   To set up autoanalysis after performing post-installation procedures, proceed to Chapter 7, “Setting Up Autoanalysis,” on page 73.
Resetting permissions for the installation

Resetting permissions on folders and files

The client installer specifies folder privileges at the time of the GeneMapper® ID-X Software installation.

However, the file system permissions set by the system administrator may not allow the GeneMapper® ID-X Software to access the GeneMapper folder following installation. Before you run the software, check the permissions to make sure that the GeneMapper® ID-X Software can access the GeneMapper folder.

If you do not have the required permissions, you may see a “can’t access file” error message when using the software. To set the privileges manually, either before running the software or in the event of an error message:

1. Right-click the AppliedBiosystems folder.
2. Select Properties, then click the Security tab.
3. In the top pane, select Users.
4. In the bottom pane, select Full Control.

![Image of AppliedBiosystems Properties window]
Chapter 5

Performing an Upgrade

This chapter covers:

- Upgrade overview ........................................... 60
- Requirements for upgrading GeneMapper® ID-X v1.0/1.0.1/1.1/1.1.1 to GeneMapper® ID-X v1.2 ............... 60
- Upgrading to the Full GeneMapper® ID-X v1.2 Software ... 62
- Upgrading to the Client GeneMapper® ID-X v1.2 Software . 63
Upgrade overview

This chapter describes how to perform upgrades of the GeneMapper® ID-X Software Versions 1.0/1.0.1/1.1/1.1.1 on your target computer.

**Note:** If you have GeneMapper® ID Software v3.x on your computer and haven’t already performed pre-installation tasks, go back to Chapter 3, “Performing GeneMapper® ID-X v1.2 Pre-Installation Procedures,” on page 21 for additional instructions. The installation may fail if these tasks are not performed first.

Requirements for upgrading GeneMapper® ID-X v1.0/1.0.1/1.1/1.1.1 to GeneMapper® ID-X v1.2

To upgrade your target computer (client or full) to GeneMapper ID-X v1.2, make certain that GeneMapper ID-X v1.0/1.0.1/1.1/1.1.1 is already installed on your system. The upgrade installer works only if it detects one of these previous versions.

**IMPORTANT!** When you upgrade on a client computer, you must also upgrade the computer that hosts the full software version on the same local area network.

**IMPORTANT!** You can automatically upgrade client-to-client versions of the GeneMapper ID-X software on a non-DC computer. For full installation on a non-DC computer, you must uninstall the previous version, then install the new full software. If you wish to upgrade from client-to-full, or from full-to-client versions, you must also uninstall the previous version, then install the new software.

**Note:** You can reuse your existing password when upgrading from GeneMapper ID-X v1.0/1.0.1/1.1/1.1.1 to GeneMapper ID-X v1.2.
Manually exporting GeneMapper ID v3.2 or GeneMapper ID-X v1.0/1.0.1/1.1/1.1.1 data objects

For information on manually exporting files out of GeneMapper ID v3.x, refer to the section on exporting items from the GeneMapper Manager in the GeneMapper® ID Software Version 3.1 User's Guide.

For information on manually exporting files out of GeneMapper ID-X v1.0/1.0.1/1.1/1.1.1, refer to the section on exporting items from the GeneMapper ID-X Manager in the GeneMapper® ID-X Software Version 1.0 Getting Started Guide.

After you have exported all your files, review the following table to determine the steps to take next.

**Table 1  Installation options following manual export (non-DC or 310 or 31xx DC computer)**

<table>
<thead>
<tr>
<th>Full Installation</th>
<th>Client Installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Uninstall GeneMapper ID v3.2. See “Uninstalling the GeneMapper ID v3.2 and GeneMapper ID-X v1.0/1.0.1/1.1.1 software” on page 27.</td>
<td>1. Uninstall GeneMapper ID v3.2. See “Uninstalling the GeneMapper ID v3.2 and GeneMapper ID-X v1.0/1.0.1/1.1.1 software” on page 27.</td>
</tr>
<tr>
<td>2. Install Full GeneMapper ID-X v1.2. See “Performing a full installation” on page 40.</td>
<td>2. Install Client GeneMapper ID-X v1.2. See “Performing a client installation” on page 49.</td>
</tr>
</tbody>
</table>
Upgrading to the Full GeneMapper® ID-X v1.2 Software

To upgrade from the Full GeneMapper® ID-X Software v1.0/1.0.1/1.1/1.1.1 to the Full GeneMapper® ID-X Software v1.2 on a non-DC computer:

1. Manually export the data objects (projects, analysis methods, etc.).
2. Manually uninstall the old GeneMapper ID-X version using your computer control panel.
3. Insert the GeneMapper® ID-X Software Version 1.2 Full Upgrade Install CD into your CD drive.
4. In the Welcome Window, click Next.
5. Read the Release notes, then click Next.
6. Click Next to install the software to the default location.
   or
   To install the GeneMapper® ID-X Software to a drive different from the default drive, select the destination folder.
7. When the software is installed, remove the installation CD from the CD drive.
8. Use the registration code from the previous GeneMapper ID-X version to launch the software.

The upgrade installation takes approximately 1 hour, depending on the computer being upgraded.
Upgrading to Full GeneMapper® ID-X v1.2 on a DC computer

To upgrade from the Full GeneMapper® ID-X Software v1.0/1.0.1/1.1/1.1.1 to the Full GeneMapper® ID-X Software v1.2 on a DC computer (coinstallation):

Note: This is not applicable to the 3500 computer.

1. Insert the GeneMapper® ID-X Software Version 1.2 Full Upgrade Install CD into your CD drive.
2. In the Welcome Window, click Next.
3. Read the Release Notes, then click Next.
4. Click Next to install the Software to the default location.
   or
   To install the GeneMapper® ID-X Software to a drive different from the default drive, select the destination folder.
5. When the software is installed, remove the installation CD from the CD drive.

The upgrade installation takes approximately 15 minutes, depending on the computer being upgraded.

Upgrading to the Client GeneMapper® ID-X v1.2 Software

Upgrading to Client GeneMapper® ID-X v1.2 on a non-DC computer

To upgrade from the Client GeneMapper® ID-X Software v1.0/1.0.1/1.1/1.1.1 to the Client GeneMapper® ID-X Software v1.2 on a non-DC computer:

1. Insert the GeneMapper® ID-X Software Version 1.2 Client Upgrade Install CD into your CD drive.
2. In the Welcome Window, click Next.
3. Read the Release Notes, then click Next.
4. Click **Next** to install the Software to the default location.

   *or*

   To install the GeneMapper® *ID-X* Software to a drive different from the default drive, select the destination folder.

5. When the software is installed, remove the installation CD from the CD drive.

The upgrade installation takes approximately 15 minutes, depending on the computer being upgraded.

---

**Upgrading to Client GeneMapper® *ID-X* v1.2 on a DC computer**

To upgrade from the Client GeneMapper® *ID-X* Software v1.0/1.0.1/1.1/1.1.1 to the Client GeneMapper® *ID-X* Software v1.2 on a DC computer (co-installation):

**Note:** This is not applicable to the 3500 computer.

1. Insert the *GeneMapper®* *ID-X* Software Version 1.2 Full Upgrade Install CD into your CD drive.

2. In the Welcome Window, click **Next**.

3. Read the Release notes, then click **Next**.

4. Click **Next** to install the Software to the default location.

   *or*

   To install the GeneMapper® *ID-X* Software to a drive different from the default drive, select the destination folder.

5. When the software is installed, remove the installation CD from the CD drive.

The upgrade installation takes approximately 15 minutes, depending on the computer being upgraded.
Performing Post-Installation Procedures

This chapter covers:

- Registering the GeneMapper® ID-X Software ................. 66
- Logging into GeneMapper® ID-X after installation ........... 67
- Connecting to a new host ........................................... 68
- Logging out of the GeneMapper® ID-X Software ........... 70
- Additional post-installation tasks ................................. 71
Registering the GeneMapper® ID-X Software

Register the GeneMapper® ID-X Software v1.2 the first time you start the software on each computer. The registration code is on the registration card packaged with the software.

**Note:** If you upgraded from GeneMapper® ID-X Software v1.0/1.0.1/1.1/1.1.1 to v1.2, use the registration code from the previous version to launch your software. Your registration code remains the same.

Enter the same registration code on each computer, based on the number of users each registration code supports.

1. On the desktop, double-click **GeneMapper ID-X v1.2** or select **Start** ➤ **All Programs** ➤ **Applied Biosystems** ➤ **GeneMapper** ➤ **GeneMapper ID-X v1.2**.

2. Complete the Registration dialog box:

![Registration Dialog Box]

3. Click **OK**.
Logging into GeneMapper® ID-X after installation

1. If the Login dialog box is not displayed in the desktop, double-click GeneMapper ID-X v1.2 or select Start ➤ All Programs ➤ Applied Biosystems ➤ GeneMapper ➤ GeneMapper ID-X v1.2.

2. In the Login to GeneMapper ID-X dialog box, enter or select “gmidx” as the administrator account user name and the temporary password, “password”, then click OK:

3. If prompted, specify a new password. Keep a record of the new password. Click OK.

   **Note:** The gmidx account requires you to set a new password when you log in for the first time. If you follow this procedure after first log in, the passwords for the accounts listed may be different from the passwords listed in this guide.

   **IMPORTANT!** Do not lose the password for the gmidx account. Applied Biosystems cannot retrieve these passwords.

4. Read the license agreement, then click Yes if you agree with the terms.

5. Review the license agreement and product warranty, then click Accept.
Connecting to a new host

If you install more than one multi-user database computer, any client computer can connect to any of the databases if the client is on the same network as the database computers.

**Note:** All client computers connecting to multi-user database computers must be running the same version of GeneMapper ID-X Software.

Users must set up separate user accounts on each multi-user database computer that they wish to access.

**Note:** For detailed information on setting up user accounts, see the GeneMapper® ID-X Software Version 1.0 Administrator's Guide.

To make the multi-user database computers available to client computers, perform the following steps for each client computer:

1. Click **New Host** in the Login to GeneMapper ID-X dialog box.

2. Complete the information in the New Host dialog box:
a. In the **Host Name** field, enter the full computer name or IP address of the multi-user database host you want to access. If the GeneMapper® ID-X Software cannot connect to the database host, the error message “You have entered an invalid host” is displayed. Click **OK** to exit, then re-enter the database host information.

b. Select the applicable machine type.

c. Click **OK**.

The Login window is updated to include the name of the new database host. The User Name list reflects the user accounts on the new database host. See the *GeneMapper® ID-X Software Version 1.0 Administrator’s Guide* for additional information.
Logging out of the GeneMapper® ID-X Software

You can close the GeneMapper® ID-X Software by:

- Selecting File ➤ Logout.
- Selecting File ➤ Exit.
- Clicking ❌ (Close).

When you log out of the GeneMapper® ID-X Software with a project that has unsaved changes, the software prompts you to save or discard the changes you made since the last time you updated the project.

If you used the File ➤ Logout command, the login window re-opens after you select either Yes or No. The GeneMapper ID-X Software closes completely if you use either File ➤ Exit or ❌ (Close).
Additional post-installation tasks

**Importing application data**

If you exported application data from GeneMapper® ID Software v3.2.x or GeneMapper® ID-X Software v1.0/1.0.1/1.1/1.1.1 before you installed GeneMapper® ID-X Software v1.2, you may wish to import the data objects (projects, analysis methods, etc.) into the GeneMapper® ID-X Software v1.2 database host computer.

Select **Tools ▶ GeneMapper ID-X Manager**. Then in the GeneMapper ID-X Manager window, click each tab to import the corresponding objects into GeneMapper ID-X v1.2.

**Creating user accounts and configuring administrative functions**

For information on creating user accounts and configuring the Security Manager, Audit Manager, and E-Signature Administrator, see the *GeneMapper® ID-X Software Version 1.0 Administrator’s Guide*.

**Setting up autoanalysis**

If you installed the GeneMapper® ID-X Software as either a remote autoanalysis configuration, co-installation, or Data Collection client installation, follow the procedures in Chapter 7, “Setting up autoanalysis on the 31xx or 3730 computer,” on page 81.
Chapter 6  Performing Post-Installation Procedures

Additional post-installation tasks
Chapter 7

Setting Up Autoanalysis

This chapter covers:

- Overview of autoanalysis process . . . . . . . . . . . . . . . . . . . . . . 74
- Determining if your computer can perform autoanalysis . . . . 76
- Autoanalysis instrument and software configurations . . . . . 77
- Overview of autoanalysis setup . . . . . . . . . . . . . . . . . . . . . . . . 78
- Setting up autoanalysis on the 31xx or 3730 computer . . . . . . 81
- Setting up autoanalysis on the 3500 computer . . . . . . . . . . . . 95
- Recommended data processing tasks . . . . . . . . . . . . . . . . . . 103
Overview of autoanalysis process

The autoanalysis process occurs in the following sequence:

**Note:** The 3500 instrument supports local analysis only.

1. Close the GeneMapper® ID-X Software and start the Autoanalysis Manager.
2. On the Data Collection (DC) computer, select the plate to run and schedule the run.
3. When the DC Software finishes a run as specified in the results group, the data (.fsa or .hid sample files) are stored in the destination specified by the DC Software results group.
4. The DC Software sends the message “Run Completed” to the Autoanalysis Manager. The Autoanalysis Manager searches for jobs every two minutes.
5. When the Autoanalysis Manager receives a “Run Completed” message, it adds the job to its job queue.
6. The Autoanalysis Manager:
   a. Opens the GeneMapper® ID-X Software.
   b. Creates a project using the name of the Data Collection results group.
7. The GeneMapper® ID-X Software:
   a. Imports the .fsa or .hid sample files from the location specified in the Data Collection results group.
   b. Uses the settings specified in the Data Collection plate record (panels and bins, analysis method, size standard) to analyze the .fsa sample files.
   c. Saves the project, then associates the data in the project with the GMIDX security group (for information on security groups, see the GeneMapper® ID-X Software Version 1.0 Administrator’s Guide).
d. Stores the results in the default host GeneMapper® ID-X Software database.

**Note:** The default host is the GeneMapper ID-X Software computer that is specified in the Login dialog box of the computer that performs autoanalysis. For instructions on changing the default host, see “Connecting to a new host” on page 68.

8. The Autoanalysis Manager:
   a. Closes the GeneMapper ID-X Software.
   b. Updates the status of the run in the Autoanalysis Manager job queue.

For information on the Autoanalysis Manager, see the *GeneMapper® ID-X Software Online Help*. 
Determining if your computer can perform autoanalysis

An autoanalysis configuration uses:

- **Data Collection Software** – Runs the instrument and collects data from samples. See “Instrument and software options for autoanalysis” on page 77 to determine if your Data Collection computer supports autoanalysis.

- **Autoanalysis Manager** – Communicates between the Data Collection Software and the GeneMapper® ID-X Software. It queues jobs and tracks the status of their processing. A job can contain a single run or multiple runs as part of a result group.

- **GeneMapper® ID-X Software v1.2** – Creates a project, imports .fsa or .hid sample files, analyzes the data, then saves the results in the multi-user database.

Figure 2 shows the relationship and interaction between the autoanalysis components.

![Figure 2 Relationship between autoanalysis components](image)

Autoanalysis can be performed from a multi-user database computer or a client computer but requires the Autoanalysis Manager.

To determine if your computer contains the Autoanalysis Manager, select **Start ➤ Applied Biosystems ➤ Autoanalysis Manager ➤ Autoanalysis Manager 5.0**.
Autoanalysis instrument and software configurations

With autoanalysis, the GeneMapper® ID-X Software v1.2 can automatically analyze data generated on the following systems:

<table>
<thead>
<tr>
<th>Genetic Analyzer Instrument</th>
<th>Compatible Data Collection Software and Operating Systems</th>
</tr>
</thead>
</table>
| Applied Biosystems 3500 Genetic Analyzer | • 3500 Data Collection v3.0  
• Windows Vista SP 1 |
| Applied Biosystems 3130/3130x/Genetic Analyzer | • 3130 Data Collection v3.0/3130x/ Data Collection v3.0  
• Windows XP, SP 2 or later |
| ABI PRISM® 3100/3100-Avant™ Genetic Analyzer | • 3100 Data Collection v2.0/3100-Avant™ Data Collection v2.0  
• Windows 2000, SP 3 or later and Windows XP SP 2 or later |
| Applied Biosystems 3730 Genetic Analyzer‡ | • 3730 Data Collection v3.0  
• Windows XP, SP 2 or later |

‡ The 3730 Genetic Analyzer does not include the 3730x/96-capillary configuration. The 48-capillary configuration is validated for analysis of data generated from Identifiler® kits using single-source data samples only.
Overview of autoanalysis setup

Local and remote autoanalysis

With the analyzers listed in Table 7, you can configure the Data Collection Software and the GeneMapper® ID-X Software v1.2 to perform data collection and then analyze the data automatically, without user interaction.

The GeneMapper® ID-X Software v1.2 can be a co-installation or a client installation on the DC computer (for local autoanalysis). Alternatively, the software can be installed on a non-DC computer and configured for remote autoanalysis on a 31xx or 3730 DC computer only, as shown Figure 3.

**Note:** If you install the GeneMapper® ID-X Software on the same computer as the Data Collection Software (co-installation), you must manually import the panel and bin files. See the GeneMapper® ID-X Software Online Help for information on this procedure.

**Note:** If you install the GeneMapper ID-X v1.2 software on the 3500 DC computer (co-installation), you will be able use the 3500 computer to perform local autoanalysis. However, if you install the GeneMapper ID-X v1.2 software on a non-DC computer, you will not be able to access the 3500 computer to perform remote autoanalysis.

![Figure 3 Examples of autoanalysis configurations](Image)
Data processing options

The Autoanalysis feature of the GeneMapper® ID-X Software allows you to set up a Data Collection run, then process the data automatically in the GeneMapper® ID-X Software. Autoanalysis can occur:

- **Locally** – from the DC computer when the Data Collection Software and GeneMapper® ID-X Software are installed on the same computer.
- **Remotely** – from the non-DC computer when the Data Collection Software (on the 31xx or 3730 only) and GeneMapper® ID-X Software are installed on different computers.

The Autoanalysis Manager is automatically installed when you install the GeneMapper® ID-X Software on a:

- DC computer as a co-installation or client installation
- Non-DC computer for remote autoanalysis

Autoanalysis Manager is not installed when you install the GeneMapper® ID-X Software on a non-DC computer in a stand-alone configuration.

If the Autoanalysis Manager is not installed on your computer and you want to use the computer for autoanalysis, uninstall the GeneMapper® ID-X Software (see “Uninstalling the GeneMapper® ID-X Software” on page 126), then reinstall for Remote Autoanalysis.

Before setting up autoanalysis:

- Ensure that the Data Collection Software and GeneMapper® ID-X Software are installed in either of the following configurations:

![Figure 4 Configurations necessary for autoanalysis](image-url)
Chapter 7  Setting Up Autoanalysis
Overview of autoanalysis setup

- If the software is installed on different computers, ensure that the two computers are connected to the same network.
- Ensure that the remote GeneMapper® ID-X Software computer has the Autoanalysis Manager installed: Select Start ▶ Applied Biosystems ▶ Autoanalysis Manager ▶ Autoanalysis Manager 5.0.
- If the Autoanalysis Manager is not installed, you must uninstall the GeneMapper® ID-X Software, then reinstall the GeneMapper® ID-X Software and select the Remote Autoanalysis option (see “Uninstalling the GeneMapper® ID-X Software” on page 126).
- Import or create analysis methods, panels, bins, and size standards on the multi-user database host computer (see the GeneMapper® ID-X Software Online Help).
- If you install the GeneMapper® ID-X Software on the same computer as the Data Collection Software (co-installation), you must manually import the panel and bin files. See the GeneMapper® ID-X Software Online Help for information on this procedure.
Setting up autoanalysis on the 31xx or 3730 computer

The autoanalysis set-up process consists of four procedures as shown in the following table.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Action</th>
<th>See page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a User Account.</td>
<td>81</td>
</tr>
<tr>
<td>2.</td>
<td>In the Data Collection Software, create an instrument protocol for autoanalysis.</td>
<td>82</td>
</tr>
<tr>
<td>3.</td>
<td>In the Data Collection Software, create a results group for autoanalysis.</td>
<td>84</td>
</tr>
<tr>
<td>4.</td>
<td>In the Data Collection Software, create a plate record for autoanalysis.</td>
<td>92</td>
</tr>
</tbody>
</table>

**Procedure 1: Creating a user account for autoanalysis**

**IMPORTANT!** The user account for autoanalysis must exist on the computer that is specified as the host computer, which may be different from the computer on which you run autoanalysis and store data files (see Figure 6 on page 104).

Create a user account for autoanalysis in GeneMapper® ID-X with the following settings (for information on creating user accounts, see the GeneMapper® ID-X Software Version 1.0 Administrator’s Guide). In the GeneMapper ID-X Software Security Manager New User screen:

1. Deselect Pre-expire.

**IMPORTANT!** If the account is set to pre-expire, you must log in with the account one time to change the password before you use the account for autoanalysis.
2. Select **Scientist** profile.

   **Note:** If you create custom profiles for your system, create a profile for autoanalysis with the following minimum privileges: Read privileges for Panel Manager, Size Standard, Analysis Method; Read and Update privileges for creating and analyzing projects.

3. For Full Name, enter **Remote Autoanalysis, Data Collection Client**, or **Co-installation**.

4. Deselect **Show EULA**.

5. Associate the user account with any user group. The project that autoanalysis creates, analyzes, and saves is associated with the **GeneMapper® ID-X** Software security group, which is accessible by all user groups.

   When you are finished, go to Procedure 2 and create an instrument protocol.

### Procedure 2: Creating an instrument protocol for autoanalysis

An instrument protocol contains all the settings needed to run the instrument, including the protocol name, type of run, run module, and dye set.

**IMPORTANT!** Create new instrument protocols after installing or reinstalling the **GeneMapper® ID-X** Software v1.0/1.0.1/1.1/1.1.1.

For more detailed information about instrument protocols, see your instrument user guide.

#### Creating instrument protocols

1. In the Navigation pane of the Data Collection Software, select **GA Instruments** ➔ **<Instrument Name>** ➔ **Protocol Manager**.

2. In the Instruments Protocols section, click **New** to open the Protocol Editor.
3. In the Protocol Editor, enter instrument protocol information:

a. Enter a name for the protocol.

b. (Optional) Enter a description for the protocol.

c. Select **REGULAR** in the Type drop-down list.

d. Select the **HIDFragmentAnalysis36_POP4_1** run module in the Run Module drop-down list.

e. Select the appropriate dye in the Dye Set drop-down list (see the table that follows to determine the dye).
Chapter 7  Setting Up Autoanalysis

Setting up autoanalysis on the 31xx or 3730 computer

f. Click OK.

When you are finished, go to Procedure 3 to create a Results Group for autoanalysis.

Procedure 3: Creating a results group for autoanalysis

Overview of results groups

Create a Results Group for each computer that performs autoanalysis.

A Results Group specifies the file names and storage location (shared folder) for .fsa sample files, and the user name and password for the GeneMapper® ID-X Software computer that performs autoanalysis. After you create the Results Group, the software can perform autoanalysis.

Create new Results Groups after installing or reinstalling the GeneMapper® ID-X Software v1.2.

IMPORTANT! The maximum number of .fsa sample files that the Data Collection Software can assign to a Results Group, when using the Analysis Type GeneMapperIDX-Generic or GeneMapperIDX-<computer name>, is 7000. After you collect 7000 .fsa sample files in a Results Group, you must create a new results group.

Kit | Dye Set
---|---
AmpFlSTR® COfiler® Kit | F
AmpFlSTR® Profiler Plus® Kit | F
AmpFlSTR® Profiler Plus ID Kit | F
AmpFlSTR® SGM Plus® Kit | F
Other 4-Dye AmpFlSTR® Kits | F
AmpFlSTR® SEfiler™ Kit | G5
AmpFlSTR® Identifier® Kit | G5
AmpFlSTR® Yfiler® Kit | G5
AmpFlSTR® Minfiler™ Kit | G5
Other 5-Dye AmpFlSTR® Kits | G5

Kit Dye Set

<table>
<thead>
<tr>
<th>Kit</th>
<th>Dye Set</th>
</tr>
</thead>
<tbody>
<tr>
<td>COfiler</td>
<td>F</td>
</tr>
<tr>
<td>Profiler Plus</td>
<td>F</td>
</tr>
<tr>
<td>Profiler Plus ID</td>
<td>F</td>
</tr>
<tr>
<td>SGM Plus</td>
<td>F</td>
</tr>
<tr>
<td>Other 4-Dye AmpFlSTR® Kits</td>
<td>F</td>
</tr>
<tr>
<td>SEfiler</td>
<td>G5</td>
</tr>
<tr>
<td>Identifier</td>
<td>G5</td>
</tr>
<tr>
<td>Yfiler</td>
<td>G5</td>
</tr>
<tr>
<td>Minfiler</td>
<td>G5</td>
</tr>
<tr>
<td>Other 5-Dye AmpFlSTR® Kits</td>
<td>G5</td>
</tr>
</tbody>
</table>

GeneMapper® ID-X Software v1.2 Installation Guide
Allelic ladder requirements and results groups

IMPORTANT! If a run folder does not contain an allelic ladder, the samples are reported as off ladder (OL) in the GeneMapper® ID-X Software. For more information, see the GeneMapper® ID-X Software Online Help.

To set up the Data Collection Software so at least one allelic ladder is present in each run folder, create a results group that groups by plate as described below, instead of by run (which is the default).

Creating a results group for autoanalysis

For each GeneMapper® ID-X Software client computer that runs autoanalysis:

1. In the Navigation pane of the Data Collection Software, select GA Instruments ▶ Results Group.

2. Click New to open the Results Group Editor, then click the tabs of the results groups and enter the information as described below.

Entering Results Group Information

1. In the General tab, enter the Results Group Name. This name is assigned as the default autoanalysis project name (all results for autoanalysis are stored in this GeneMapper® ID-X Software project). The Results Group name must be unique to the Data Collection Software.

2. (Optional) Enter the Results Group Owner.

3. (Optional) Enter a Results Group Comment.
Chapter 7 Setting Up Autoanalysis

Setting up autoanalysis on the 31xx or 3730 computer

Entering Analysis Parameters

1. Click the Analysis tab.

2. For the Analysis Type, select GeneMapper® ID-X-<computer name> (the name of the host or client computer on which you intend to run autoanalysis).

   Note: The computer names are added to the Analysis Type list when you install the GeneMapper® ID-X Software as a co-installation or client installation on the Data Collection computer, or choose the remote autoanalysis option for the non-DC computer (31xx and 3730 computers only).

   Note: You cannot perform autoanalysis if you select GeneMapper® ID-X-Generic.

3. Select Do Autoanalysis.

4. Select Results Group Entry Complete to start autoanalysis after all samples that use the same results group (all samples on the plate) have been run and to ensure that each run folder contains an allelic ladder.

   IMPORTANT! If a run folder does not contain an allelic ladder, the samples are reported as off ladder (OL) in the GeneMapper® ID-X Software. For more information, see the GeneMapper® ID-X Software Online Help.
5. In the Login ID and Password fields, enter a GeneMapper® ID-X Software user account username and password for the computer on which you intend to run autoanalysis. This account must exist on the computer specified as the default host. The default host computer may not be the computer on which you perform autoanalysis (the computer running Autoanalysis Manager) (see Figure 6 on page 104).

**IMPORTANT!** The GeneMapper ID-X Software requires a user account with a Scientist or higher security profile to perform autoanalysis (see “Procedure 1: Creating a user account for autoanalysis” on page 81).
Specifying the Sample File Storage Location

1. Click the **Destination** tab.

2. Specify the location in which to store the .fsa sample files.

3. Select **Use Custom Location**.

4. Set the destination as described in the following table.
### Chapter 7  Setting Up Autoanalysis

*Setting up autoanalysis on the 31xx or 3730 computer*

<table>
<thead>
<tr>
<th>For...</th>
<th>Do the Following...</th>
</tr>
</thead>
</table>
| Local autoanalysis | 1. Click **Browse**, then select a destination.  
2. Click **Test**.                                                                                                                                                                                                 |
| Remote autoanalysis | 1. Before you specify the destination, verify that you can connect to the computer on which you intend to store the .fsa sample files and that the shared folder you previously created (see page 84) is accessible from that computer.  
**Note:** To optimize data sharing, store files on a non-GeneMapper® ID-X Software computer (see page 103).  
ea. On the Data Collection computer, select the **Start** menu, then select **Run**.  
b. Enter the names of the computer on which you intend to store the .fsa sample files and the shared folder, using the following format:  
\`\<server name\>\<shared folder name\>`  
For example: `\GMID_PC\Remote_AutoAnalysis`  
c. Click **OK**.  
If Windows Explorer opens to the shared folder on the designated computer, the computer and shared folder are accessible. Close Windows Explorer, then proceed to step 2.  
If Windows Explorer does not open to the shared folder on the designated computer, either the computer is not accessible, or the shared folder is not set up correctly. Troubleshoot your network, computer, or shared folder problem before proceeding to step 2.  
2. In the Destination tab (see page 88), enter the names of the computer on which you intend to store the .fsa sample files and the shared folder, using the format shown in step 1b.  
3. Click **Test** to test the location path name connection.  
If the test:  
- **Passes** – The message “Test succeeded” is displayed.  
- **Fails** – The message “Could not make the connection. Please check that the Path Name is correct” is displayed. Make sure you correctly entered the computer and shared folder names, then troubleshoot your network or computer before continuing. |
Creating sample and name plates

In the naming tab, provide information about the samples:

1. Click the **Naming** tab.

2. From the Format list in the Sample File Name Format section (top), select a series of fields to create unique sample names, for example, Well Position, Sample Name, and Capillary Position.

3. From the Format list in the Run Folder Name Format section, select **Plate Name**.

   **IMPORTANT!** To ensure that the run folder includes at least one allelic ladder for genotyping, the run folder must be grouped by plate, not by run.

When you select Plate Name, an INVALID NAME message is displayed. Disregard the message. All samples from the plate are saved into one run folder.

**Note:** Sample name, run folder name, and path name, combined, can contain no more than 250 characters.
Setting automated processing

1. Click the Automated Processing tab.

   **Note:** This tab is available only if you selected
   GeneMapperIDX-<computer name> in step 2 on page 86.

2. Select Only when the result group is complete to analyze after
   all the samples that use the same results group have been
   processed and click OK to save the results group.

When you are finished, go to Procedure 4 to create a plate record for
autoanalysis.
Procedure 4: Creating a plate record for autoanalysis

A plate record specifies the instrument protocol, results group, and analysis parameters for a run of samples. For more information about plate records, see your instrument user guide.

**IMPORTANT!** Create new plate records after installing or reinstalling the GeneMapper® ID-X Software v1.2, and before each autoanalysis run. This procedure is provided in the *GeneMapper® ID-X Software Online Help.*

In the Navigation pane of the Data Collection Software, click the **Plate Manager** icon to display the Plate Editor.

**IMPORTANT!** Before you can create a new plate record, you must specify or import the size standards, panels, and analysis methods in the GeneMapper ID-X Software, then synchronize the Data Collection Software with the GeneMapper® ID-X Software (see page 115).

**Defining new plate information**

1. Click **New** to open the New Plate Dialog box.
2. Enter a name for the plate. The Plate Name is the name assigned to the run folder that resides in the shared folder where the .fsa sample files are stored.
3. (Optional) Enter a description for the plate.
4. Select **GeneMapperIDX-<computer name>** (the name of the computer that you intend to have run autoanalysis) in the Application drop-down list.
5. Select **96-well** or **384-well** in the Plate Type drop-down list.
6. Enter names for the owner and operator.
7. Click **OK**.
Chapter 7  Setting Up Autoanalysis

Setting up autoanalysis on the 31xx or 3730 computer

For each row in the Plate Editor (see page 94), describe the sample:

1. Enter the name of the sample.
   After you make selections for the first row, you can select the row, then press Ctrl+D to auto-populate (fill-down) the remaining rows.

2. (Optional) Enter a comment about the sample. This information is displayed in the Comment field of the Samples table in the GeneMapper® ID-X Software.

3. Enter a priority number to specify the sequence in which the samples are run.

4. Specify sample type:
   a. Select Allelic Ladder as the sample type for the appropriate wells (you need at least one allelic ladder per plate to allow genotyping).
   b. Select Positive Control or Negative Control for your control samples to allow an automated concordance check to ensure that the:
      • Positive control produces the expected profile.
      • Negative control does not contain peaks called above your peak amplitude threshold.
Chapter 7  Setting Up Autoanalysis
Setting up autoanalysis on the 31xx or 3730 computer

c. Select Sample for all other samples.

5. Select a size standard from the drop-down list.

**IMPORTANT!** If the expected size standard, panel, and analysis method are not listed, you may need to synchronize the Data Collection Software and the GeneMapper® ID-X Software. See page 115.

6. Select an applicable AmpFSTR® kit and panel from the drop-down list.

7. Select an analysis method from the drop-down list.

8. (Optional) Enter text in the user-defined text columns.

9. Select the results group you created using the procedures on page 84.

10. Select the instrument protocol you created using the procedures on page 82. Click OK.

Plate editor

For more information on the Plate Editor, see your instrument user guide. For information on performing autoanalysis and using the Autoanalysis Manager, see the GeneMapper® ID-X Software Online Help.

GeneMapper® ID-X Software v1.2 Installation Guide
Setting up autoanalysis on the 3500 computer

The autoanalysis set-up process consists of four procedures as shown in the following table.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Action</th>
<th>See page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a User Account.</td>
<td>95</td>
</tr>
<tr>
<td>2.</td>
<td>In the 3500 Series Data Collection Software, create an HID analysis protocol.</td>
<td>96</td>
</tr>
<tr>
<td>3.</td>
<td>In the Data Collection Software, add the HID analysis protocol to an assay.</td>
<td>99</td>
</tr>
<tr>
<td>4.</td>
<td>In the 3500 Series Data Collection Software, create a plate with autoanalysis enabled.</td>
<td>100</td>
</tr>
</tbody>
</table>

Procedure 1: Creating a user account for autoanalysis

On the 3500 Data Collection computer, create a user account in GeneMapper ID-X for autoanalysis with the following settings (for information on creating user accounts, see the GeneMapper® ID-X Software Version 1.0 Administrator’s Guide). In the GeneMapper ID-X Software Security Manager New User screen:

1. In the GeneMapper ID-X main window, select Admin ▶ Security Manager.
2. Select File ▶ New User.
3. Deselect Pre-expire.

IMPORTANT! If the account is set to pre-expire, you must log in with the account one time to change the password before you use the account for autoanalysis.
4. Select **Scientist** profile.

   **Note:** If you create custom profiles for your system, create a profile for autoanalysis with the following minimum privileges: Read privileges for Panel Manager, Size Standard, Analysis Method; Read and Update privileges for creating and analyzing projects.

5. For Full Name, enter **Data Collection Client** or **Co-installation**.

6. Deselect **Show EULA**.

7. Associate the user account with any user group. The project that autoanalysis creates, analyzes, and saves is associated with the GeneMapper® ID-X Software security group, which is accessible by all user groups.

When you are finished, go to Procedure 2 and create an HID analysis protocol.

**Procedure 2: Create an HID analysis protocol**

For detailed procedures, see the 3500 Series User Guide.

1. In the 3500 Series Data Collection Software, select **Library** in the menu bar to access the Library workflow.
2. Access the HID Analysis Protocols library.

3. Click **Create**.

4. In the Create New **HID Analysis Protocol** dialog box (**Figure 5 on page 98**), specify settings (see **Table 8 on page 98**).

5. Select the remaining secondary analysis items, then click **Save**.

**Note:** If the analysis method, size standard, or panel of interest is not displayed in a list, re-select the secondary analysis software instance to update the list, or re-start the GeneMapper **ID-X** software.
Chapter 7  Setting Up Autoanalysis

Setting up autoanalysis on the 3500 computer

Figure 5  Create New HID Analysis Protocol

Table 8  HID Analysis protocol settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protocol Name</td>
<td>Name of the protocol. Names must be unique.</td>
</tr>
<tr>
<td>Description</td>
<td>Optional text entry.</td>
</tr>
<tr>
<td>Lock</td>
<td>When enabled, allows the entry to be unlocked and modified only by the user who created it, the administrator, or another user with unlock permissions. Useful when your system includes the SAE module (described in the 3500 Series User Guide).</td>
</tr>
<tr>
<td>Application Type</td>
<td>Automatically set to HID.</td>
</tr>
</tbody>
</table>
Chapter 7 Setting Up Autoanalysis

Setting up autoanalysis on the 3500 computer

Table 8  HID Analysis protocol settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Analysis Software</td>
<td>Confirm that GeneMapper® ID-X is displayed for the Software Type and the Data Collection computer name is displayed for the Software Location. If these items are not displayed, make sure the GeneMapper® ID-X software is installed on the Data Collection computer.</td>
</tr>
<tr>
<td>IMPORTANT! The secondary analysis software must be installed and properly configured with the 3500 Series Data Collection Software before it is listed as a selection in this screen.</td>
<td></td>
</tr>
<tr>
<td>IMPORTANT! The auto-analysis settings you specify for the plate to run with this protocol must contain the same secondary software and location settings. For more information, see “Procedure 4: Create a plate with autoanalysis enabled” on page 100.</td>
<td></td>
</tr>
<tr>
<td>Secondary Analysis Software Instance</td>
<td>Name of the Data Collection computer.</td>
</tr>
<tr>
<td>Properties</td>
<td>GeneMapper® ID-X analysis method, size standard, and panel to use for auto-analysis.</td>
</tr>
<tr>
<td>Note: If the appropriate items are not listed, restart the GeneMapper® ID-X software and the Data Collection Software.</td>
<td></td>
</tr>
</tbody>
</table>

Procedure 3: Add the HID analysis protocol to an assay

1. Select Library in the menu bar to access the Library workflow.

2. Access the Assays library.

3. Select an assay for the kit you will run using auto-analysis.
4. Click 

   **Duplicate**, select the “Copy of” assay you created, then click 

   **Edit**.

5. Change the assay name to “original name for autoanalysis.”

6. In the GeneMapper IDX Protocol field, select the HID analysis protocol you created on page 96 (HID analysis protocol = GeneMapper IDX Protocol).

7. Click **Save**.

**Procedure 4: Create a plate with autoanalysis enabled**

**Create a plate**

1. In the 3500 Series Data Collection Software Dashboard, click 

   **Create Plate From Template**.

2. Select an HID template, then click **Open**.

3. In the Define Plate Properties screen, set the plate properties.

**Specify auto-analysis settings**

1. In the lower part of the Define Plate Properties screen, select 

   **Perform Auto-Analysis**.
2. Confirm that GeneMapperIDX is displayed for the Software Type and the Data Collection computer name is displayed for the Software Location. If these items are not displayed, make sure the GeneMapper ID-X software must be installed on the Data Collection computer.

3. Enter the username and password for the account you created for autoanalysis on page 95.

4. Select Only when the results group is complete to ensure that each run folder contains at least one allelic ladder sample.

   IMPORTANT! If a run folder does not contain an allelic ladder sample, the samples are reported as off ladder (OL) in the GeneMapper® ID-X Software.

5. Click Save, then click Assign Plate Contents to advance to the next screen.

Assign plate contents

1. Assign sample names and sample types as described in the 3500 Series User Guide.
2. Select the wells containing samples, click **Actions** in the Assay group box, then select **Add from Library**.

3. Select the assay you created on page 99.

4. Select a file name convention and a results group.

   **IMPORTANT!** If a run folder does not contain an allelic ladder sample, the samples are reported as off ladder (OL) in the GeneMapper® ID-X Software. Select a results group that places at least one allelic ladder sample in a run folder.

5. Select **Save Plate**.

6. (Optional) To save this plate as a template for future autoanalysis runs, select **Save As Template**.
Recommended data processing tasks

Optimizing data sharing

Overview

If you store .fsa or .hid sample files on a GeneMapper® ID-X Software computer (i.e., the computer that creates the project AND stores the sample files), only the computer that created the project can reanalyze the project. As a result, any other computer must reassociate the files to reanalyze the project.

Additionally, if you export/import reference data and projects following installation but do not reassociate .fsa or .hid sample files, you can view results and make or edit allele calls, but you cannot reanalyze the projects.

To reanalyze projects:

1. Move .fsa or .hid sample files to a non-GeneMapper® ID-X Software computer to optimize file sharing.

2. Reassociate the .fsa or .hid sample files with the imported projects (Edit > Define New Sample Path) to view raw and EPT data and reanalyze the imported projects on your client computer.

Figure 6 shows the recommended configuration for optimizing data sharing.
The following sections describe data optimization in detail. For additional details on how to perform each procedure, see the GeneMapper® ID-X Software Online Help.

Remote autoanalysis of data requires a shared folder in which to store .fsa sample files. To make the sample data files accessible to all client computers, set up the shared folder on a computer that is not running the GeneMapper® ID-X Software.

On the computer on which you intend to store the .fsa sample files:

1. Select Start ▶ My Computer, or double-click My Computer on your desktop, then double-click the drive on which you want the shared folder.

2. Select File ▶ New ▶ Folder.
3. Name the folder (for example, **Remote_Autoanalysis**).

4. Right-click the new folder, then select **Properties**.

5. In the Sharing tab, select **Share this folder**.

6. (Optional) Enter a comment for the folder.

7. Click **OK**.
If you use a Microsoft® Windows® XP operating system, modify the permissions and security settings of the shared folder:

1. Right-click the shared folder, then select Properties.
2. Select the Sharing tab, then click Permissions.
3. In the Permissions for \(<shared\text{ folder\name}>\) dialog box, select the check box for Full Control in the Allow column.
4. Click OK.
5. Select the **Security** tab, then click **Add**.

6. In the Select Users, Computers, or Groups dialog box, enter **Guest** in the “Enter the object names to select” field.

7. Click **OK**.
8. In the Group or user names list box in the Security tab, configure guest access:
   a. Select Guest.
   b. Select the check box for Full Control in the Allow column.
   c. Click OK.

   The shared folder is now configured for use.
If you use a Microsoft® Windows® XP operating system, modify the permissions and security settings of the shared folder:

1. Right-click the shared folder, then select **Properties**.
2. Select the **Sharing** tab, then click **Advanced Sharing**.
3. Set permissions:
   a. Click **Permissions**.
   b. In the Permissions for *<shared folder name>* dialog box, select the check box for **Full Control** in the Allow column.

4. Click **OK**.
5. Select the **Security** tab, then click **Edit**.

![Security tab in the Test Properties window](image-url)
6. Add a guest user:
   
   a. Click Add.
   
   b. In the Select Users, Computers, or Groups dialog box, enter Guest in the “Enter the object names to select” field.

7. Click OK.
8. In the Group or user names list box in the Security tab, configure guest access:
   a. Select Guest.
   b. Select the check box for **Full Control** in the Allow column.
   c. Click OK.

The shared folder is now configured for use.

**Importing and reassociating data files**

Depending on your current network configuration, you can import and reassociate the files in two ways:

- If the .fsa or .hid sample files are stored on a non-GeneMapper® *ID-X Software* computer other than a user’s local computer – The software saves the full networked path location of the .fsa or .hid sample files (for example: //server/folder/folder*.fsa). Because the path location is available to GeneMapper *ID-X*, any computer in the network can access the project and reanalyze it without reassociating the files.
Chapter 7 Setting Up Autoanalysis

Recommended data processing tasks

- If the .fsa or .hid sample files are stored on a user’s local computer (that is, the computer that creates the project AND stores the sample files) – The software saves the path location of the .fsa or .hid sample files, but not the name of the computer on which the files reside (for example: C:/folder/folder*.fsa). The local computer can reanalyze the files because GeneMapper ID-X searches the local computer for the .fsa or .hid sample files. However, the name of the computer is not available to other computers running GeneMapper ID-X, therefore they cannot reanalyze projects without first reassociating files (Edit » Define New Sample Path) (see Figure 7 for file storage comparisons).

![Diagram of file storage comparisons](image)

**Figure 7** Storing .fsa or .hid sample files: non-GeneMapper® ID-X Software computer vs. local computer

- Sample files (.fsa) stored on a server computer not running GeneMapper® ID-X Software
  - Multi-user Database Computer
  - GeneMapper® ID-X Software
  - Multi-user database
  - Server computer (not running GeneMapper® ID-X Software)
  - \Lab01\Project1\fsa files
  - Can open the project and reanalyze because full path location (\Lab01\Project1) is stored in database.

- Sample files (.fsa) stored on a computer running GeneMapper® ID-X Software
  - Multi-user Database Computer
  - GeneMapper® ID-X Software
  - Multi-user database
  - C:\Lab01\Project1\fsa files
  - Client computer
  - GeneMapper® ID-X Software
  - Can open the project and adds samples from server. Sample information including full path location, (\Lab01\Project1) is stored in database.
Synchronizing GeneMapper® ID-X Software with the Data Collection Software

After you install the GeneMapper® ID-X Software, and any time you create or change analysis methods, panels, or size standards in the GeneMapper® ID-X Software, you must synchronize the new data with the Data Collection Software before you can select the updated items in the Data Collection Software plate record.

To synchronize the GeneMapper® ID-X Software with the Data Collection Software:

1. Select File ▶ Exit to close the GeneMapper® ID-X Software.

2. Verify that the Data Collection Software is running on the Data Collection computer. If not, start the Data Collection Software. For information on starting the Data Collection Software, see “Starting the Data Collection Software on the Data Collection computer” on page 32.

3. On your desktop:
   Double-click GeneMapper ID-X v1.2, or
   Select Start ▶ All Programs ▶ Applied Biosystems ▶ GeneMapper ▶ GeneMapper ID-X v1.2 and log in.
Chapter 7 Setting Up Autoanalysis

Recommended data processing tasks

GeneMapper® ID-X Software v1.2 Installation Guide
Appendix A

Installing the Generic Updater Software

This appendix covers:

- Installing the Generic Updater Software ................. 118
- Removing the Generic Updater Software ................. 120
Installing the Generic Updater Software

The Generic Updater software is an add-on to the 3730 and 3130 Data Collection 3.0 software only. Use the Generic Updater to define custom plates and write sample files to be used with the GeneMapper® ID-X Software v1.2.

If you have either 3730 or 3130 Data Collection 3.0 software installed on your computer, and you do not intend to install the GeneMapper® ID-X Software v1.2 on the same computer for either local or remote autoanalysis, you can install the Generic Updater software on the Data Collection computer.

The generic Plate Editor, residing in the Plate Manager function, has columns for GeneMapper ID-X plate data that can be edited as text fields. The software provides you with the option to add generic or non-automated GeneMapper ID-X plate definitions and sample files to your Data Collection Software installation.

To review the requirements for installing the Generic Updater software, see “Installation options” on page 3.

1. Insert one of the following CDs into the Data Collection computer CD drive:
   - GeneMapper® ID-X Software Version 1.2 Full Install CDs - Disk 1
   - GeneMapper® ID-X Software Version 1.2 Client Install CD

2. Ensure that the Data Collection Software is running (see page 32).

3. On the splash screen, click Software Extras, then on the next screen click Generic Updater.

4. On the following screen, click Install Generic Updater.

5. Click Browse, then select a location for the Generic Updater zip files and click Unzip to extract the files.

6. Remove the GeneMapper® ID-X Software v1.2 CD from the CD drive.
7. Navigate to the extracted folder on your hard drive. Open the Deployment-Generic folder, then double-click `RegisterGMID-XGeneric.exe`.

8. Click **OK** when you see the message “Application GeneMapper® successfully registered in JNDI.”

9. Stop the Data Collection Software and restart your computer. Start the Data Collection Software and open the Viewer window, then use the Plate Manager to create new GeneMapper ID-X Generic plate definitions.

For instructions on creating and using GeneMapper ID-X Generic plates, see the User Guide for your specific instrument.

**Resolving installation problems**

If `RegisterGMID-XGeneric.exe` reports an installation problem:

1. Close the window and check the `JNDIRegistrationGMID-XGeneric` log file in the extracted folder.

2. Check your Data Collection installation to verify that the Data Collection Software is running.

3. Try running `RegisterGMID-XGeneric.exe` again.
Removing the Generic Updater Software

**IMPORTANT!** If you decide to install the GeneMapper® ID-X Software directly onto the Data Collection computer or as a remote autoanalysis configuration, you must first remove the Generic Updater Software from the Data Collection computer.

To uninstall the Generic Updater Software:

1. Ensure that the Data Collection Software is running (see page 32).

2. Navigate to the extracted folder on your hard drive.

3. Open the Deployment-Generic folder, then double-click UnRegisterGMID-XGeneric.exe to remove the GeneMapperIDX-Generic option from the Data Collection Software.

4. Click **OK** when you see the message “Application GeneMapper® successfully unregistered in JNDI.”

5. Verify that the Generic Updater Software was removed:
   a. Open the Data Collection Viewer window.
   b. Open the Plate Manager.
   c. Verify that the GeneMapperIDX-Generic option is not available as an application choice.

6. Delete the Generic Updater Software files from your hard drive.
Appendix A  Installing the Generic Updater Software  
Removing the Generic Updater Software

Resolving uninstallation problems

If `UnRegisterGMID-XGeneric.exe` reports a problem and the Generic Updater software is still displayed in the Data Collection Viewer Plate Manager:

1. Check the `JNDIRegistrationGMID-XGeneric` log file in the extracted folder.
2. Check your Data Collection installation to verify that the Data Collection Software is running.
3. Run `UnRegisterGMID-XGeneric.exe` again.
Appendix A  Installing the Generic Updater Software
Removing the Generic Updater Software
This appendix covers:

- Troubleshooting tasks ........................................... 124
- Troubleshooting tools ............................................ 131
Troubleshooting tasks

Disabling firewall protections

During a full GeneMapper® ID-X Software installation, the security firewall settings may prevent the database from installing. You may see Windows security alerts that prompt you to “keep blocking” or “unblock” the security firewalls. Alternatively, it may appear that the installation was complete, but when you start the software, the database may not launch.

1. Before installing GeneMapper ID-X v1.2, disable the firewall settings:
   - For Windows XP select: Start ▶ Control Panel ▶ Windows Firewall
   - For Windows Vista select: Start ▶ Settings ▶ Control Panel ▶ Windows Firewall

2. During installation, if you are prompted with Windows firewall alerts, click Unblock and proceed with installation.

   If the software application doesn’t launch:
   - Uninstall the software (see “Uninstalling the GeneMapper® ID-X Software” on page 126).
   - Disable the firewall settings
     - For Windows XP select: Start ▶ Control Panel ▶ Windows Firewall
     - For Windows Vista select: Start ▶ Settings ▶ Control Panel ▶ Windows Firewall

   or

   Disable the firewall settings for earlier Windows operating systems. Go to Start ▶ Settings ▶ Control Panel ▶ Security Center for Windows online support.

3. Reinstall the software for your specific ID-X configuration.

4. Reset firewall.
Canceling an installation

DO NOT cancel an installation before the installation process is finished. If you do so, or if the installation otherwise stalls, you may need technical support to perform an uninstall. To uninstall your installation, see “Uninstalling the GeneMapper® ID-X Software” on page 126. If uninstallation fails, contact your local Applied Biosystems technical support organization.

General installation solutions

Note: You may need to send the GeneMapper ID-X install and MSI log files to Applied Biosystems Technical Support if the troubleshooting procedures in this appendix do not solve the installation problem.

If you have trouble installing the GeneMapper® ID-X Software v1.0 or v1.1 on your computer:

<table>
<thead>
<tr>
<th>Task</th>
<th>See page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Obtain the installation log file.</td>
<td>125</td>
</tr>
<tr>
<td>2. Check the database installation.</td>
<td>126</td>
</tr>
<tr>
<td>3. If necessary, uninstall the software.</td>
<td>126</td>
</tr>
<tr>
<td>4. If necessary, have a knowledgeable technician run the clean-up utility.</td>
<td>128</td>
</tr>
</tbody>
</table>

Obtaining the installation log file

To obtain the installation log file, go to:

\`x:\{installdir}\AppliedBiosystems\GeneMapper ID-X\` where \`x\` is the drive on which the GeneMapper ID-X Software is installed and \`{installdir}\` is the user-selected installation path.

- You will find 2 logs for the full installation:
  - GMIDXInstall.log
  - GMIDX_MSI.log
- You will find 2 logs for the client installation:
  - GMIDXClientInstall.log
Appendix B  Troubleshooting the Installation

Troubleshooting tasks

Checking the database installation

1. Select Start ➔ All Programs ➔ Accessories ➔ Command Prompt.
2. Enter sqlplus, then press Enter.
3. Enter the user name, system, then press Enter.
4. Enter the password, manager, then press Enter.
   - If a “Connected to:” message is displayed, the database is installed correctly.
   - If no “Connected to:” message is displayed, the database is not installed correctly. Complete Table 6, “Troubleshooting Checklist,” on page 131, then contact Applied Biosystems Technical Support.

Uninstalling the GeneMapper® ID-X Software

To uninstall the GeneMapper® ID-X Software and the multi-user database:

1. If you are uninstalling a co-installation, Data Collection client installation, or a remote autoanalysis configuration, start the Data Collection Software (see page 32).
2. Close the GeneMapper® ID-X Software and all other applications, then restart the computer before proceeding with the uninstall.

IMPORTANT! If you do not restart the computer before proceeding with the uninstall and/or if the uninstall does not complete successfully the first time, perform this procedure a second time. If the uninstall still does not work, have a knowledgeable technician review and proceed with “Running the clean-up utility” on page 128 or contact Applied Biosystems Technical Support to proceed.

3. Select Start ➔ Control Panel.
Appendix B  Troubleshooting the Installation
Troubleshooting tasks

4. Double-click **Add or Remove Programs**.

   **Note:** If a message indicates that you need administrator rights or privileges, log off the computer, then log on again as a user with administrator privileges.

   **Note:** If you receive an error message, dismiss the message and proceed to “Running the clean-up utility” on page 128.

5. Select the GeneMapper® **ID-X** Software.

6. Click **Change/Remove**. The InstallShield Wizard opens.

7. In the Welcome page, select **Remove**, then click **Next**.

8. At the prompt, click **OK** to verify the uninstall.
   - If you are uninstalling a **Co-installation or Data Collection client** installation, the message below appears. Be sure the Data Collection Service Console is open, then click **OK** to start the uninstall.
   - If you are uninstalling a **remote autoanalysis** configuration, no message is displayed; however, the Data Collection Software must be running and the Service Console must be open on the remote Data Collection computer to uninstall a remote autoanalysis configuration.
9. When the Maintenance Complete window opens, finish the uninstallation process:

**IMPORTANT!** If you uninstall a *co-installation* or *Data Collection client* installation, stop the Data Collection Software before restarting your computer by clicking **Stop All** in the Service Console.

![Service Console](image)

**Running the clean-up utility**

Run the clean-up utility under only the following conditions:

- You have attempted the uninstall procedure using the **Add/Remove** Program uninstall option, and
- The GeneMapper ID-X software files were not removed or were only partially removed.

Have only a knowledgeable technician run the `msicuu2.exe` utility to clean up the remaining files.
To perform the clean-up procedure:

1. Insert the GeneMapper® ID-X Software CD, then go to DVD/CD-RW Drive > Utilities.

2. Run msicuu2.exe to install the utility.

3. Launch the utility from the desktop icon or from Start > Programs > Windows to install.

4. Select the GeneMapper ID-X application from the list provided, then click Remove.
   a. Check to ensure that the gmidx install folder and oraclegmidx folder under your {installdir} are deleted.
   b. Check to ensure that the Oracle folder in the Program Files folder is deleted.

5. Delete variable strings:

   **IMPORTANT!** Steps 5 and 6 must be performed carefully and correctly. If they are not performed correctly, other applications could stop working, and the stability of your system could be at risk. If you do not feel comfortable performing these steps, please contact your system administrator to perform them for you.

   a. Right-click on My Computer, then select Properties.
   b. Click the Advanced tab.
   c. Click Environment Variables.
   d. In the System variables Variable pane, delete the words ORACLE_HOME and ORACLE_HOSTNAME.
   e. In the System variables Variable pane, select the Path variable and click Edit.
   f. Remove the path to oraclegmidx from the path environment variable.
   g. Click OK to exit the Environment Variables dialog box and OK to exit the System Properties dialog box.
6. Go to Start ➤ Run and enter regedit. In the left-pane of the Registry Editor, open the following folders sequentially:
HKEY_LOCAL_MACHINE ➤ SYSTEM ➤ CurrentControlSet ➤ Services.

   a. In the Services folder, remove all Oracle folders containing IFA letters only.
      • OracleIFAGMIDXCMAn
      • OracleIFADataGatherer
      • OracleIFAGMIDXTNSListener
      • OracleIFAAgent
      • OracleIFAClientCache
      • OracleIFAGMIDXCMAdmin
      • OracleServiceIFA
      • OracleJobSchedulerIFA

   b. Log off and reboot the system.
Troubleshooting tools

Complete the Troubleshooting Checklist and Interdepartment Forms before contacting Applied Biosystems Technical Support for assistance.

### Checklist

<table>
<thead>
<tr>
<th>Check</th>
<th>Information for Technical Support</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Summarize the problem:</td>
</tr>
<tr>
<td></td>
<td>Can you repeat the problem?</td>
</tr>
<tr>
<td></td>
<td>If yes, list the steps that you perform:</td>
</tr>
<tr>
<td>1.</td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td></td>
</tr>
<tr>
<td>3.</td>
<td></td>
</tr>
<tr>
<td>4.</td>
<td></td>
</tr>
<tr>
<td>5.</td>
<td></td>
</tr>
<tr>
<td>6.</td>
<td></td>
</tr>
<tr>
<td>7.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Applied Biosystems personnel that you have contacted:</td>
</tr>
<tr>
<td></td>
<td>❑ Field Applications Specialist</td>
</tr>
<tr>
<td></td>
<td>❑ Field Service Engineer</td>
</tr>
<tr>
<td></td>
<td>❑ Technical Support</td>
</tr>
<tr>
<td></td>
<td>❑ Sales Representative</td>
</tr>
<tr>
<td></td>
<td>❑ Order Administration</td>
</tr>
<tr>
<td></td>
<td>❑ Other</td>
</tr>
</tbody>
</table>
### Appendix B  Troubleshooting the Installation

#### Troubleshooting tools

<table>
<thead>
<tr>
<th>Check</th>
<th>Information for Technical Support</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Computer specifications:</strong></td>
</tr>
<tr>
<td></td>
<td>• Operating system:</td>
</tr>
<tr>
<td></td>
<td>• Version:</td>
</tr>
<tr>
<td></td>
<td>• Processor:</td>
</tr>
<tr>
<td></td>
<td>• Memory:</td>
</tr>
<tr>
<td></td>
<td>• Hard disk space:</td>
</tr>
<tr>
<td></td>
<td>• Hard disk configuration:</td>
</tr>
<tr>
<td></td>
<td><strong>Software installed:</strong></td>
</tr>
<tr>
<td></td>
<td>❑ Data Collection Software version:</td>
</tr>
<tr>
<td></td>
<td>❑ Status of Data Collection services:</td>
</tr>
<tr>
<td></td>
<td>❑ GeneMapper ID-X Software version:</td>
</tr>
<tr>
<td></td>
<td>❑ Other Applied Biosystems software:</td>
</tr>
<tr>
<td></td>
<td><strong>Computer login information:</strong></td>
</tr>
<tr>
<td></td>
<td>• User privileges:</td>
</tr>
<tr>
<td></td>
<td>• Local or networked domain:</td>
</tr>
<tr>
<td></td>
<td><strong>Software configuration installed:</strong></td>
</tr>
<tr>
<td></td>
<td>❑ Co-installation</td>
</tr>
<tr>
<td></td>
<td>❑ Remote autoanalysis</td>
</tr>
<tr>
<td></td>
<td>❑ Stand-alone</td>
</tr>
<tr>
<td></td>
<td>❑ Multi-user database</td>
</tr>
<tr>
<td></td>
<td><strong>Instrument and instrument computer information:</strong></td>
</tr>
<tr>
<td></td>
<td>• Model:</td>
</tr>
<tr>
<td></td>
<td>• Data Collection Software version:</td>
</tr>
<tr>
<td></td>
<td>• Status of Data Collection services:</td>
</tr>
<tr>
<td></td>
<td>• Other Applied Biosystems software:</td>
</tr>
<tr>
<td></td>
<td>• Capillary length:</td>
</tr>
<tr>
<td></td>
<td>• Capillary lot number:</td>
</tr>
<tr>
<td></td>
<td>• Run module:</td>
</tr>
<tr>
<td></td>
<td>• Dye set:</td>
</tr>
<tr>
<td></td>
<td><strong>Chemistry kit or reagent, with version number:</strong></td>
</tr>
</tbody>
</table>
Interdepartmental forms

Answering questions in the following forms helps manage complex troubleshooting procedures. Your answers will be shared among support groups, product groups and software development teams at Applied Biosystems.

To address any issues that may arise when installing or running the software, please answer the applicable list of questions, and collect the necessary files before contacting Technical Support.
Appendix B  Troubleshooting the Installation

For installation issues

Collect the following files and complete the questions below:

For full installation:
- GMIDXInstall.log
- GMIDX_MSI.log

For client installation:
- GMIDXClientInstall.log
- GMIDXClient_MSI.log

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do the computer and operating system meet the required computer specifications?</td>
<td>(See Chapter 2, “Installation Requirements,” on page 13.) List any potential discrepancies.</td>
</tr>
<tr>
<td>Did you receive any error messages or alerts? If so, what did they say? At what point during the installation process did these errors/alerts occur?</td>
<td></td>
</tr>
<tr>
<td>How many installation attempts have you tried?</td>
<td></td>
</tr>
<tr>
<td>Are you logged in to the local computer?</td>
<td></td>
</tr>
<tr>
<td>Is the TCP/IP configured?</td>
<td></td>
</tr>
<tr>
<td>Do you have administrative privileges?</td>
<td></td>
</tr>
<tr>
<td>Is this setup stand-alone, networked, or connected to a Genetic Analyzer?</td>
<td></td>
</tr>
</tbody>
</table>
## For post-installation related issues

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Do the computer and operating system meet the required computer specifications?</td>
<td>(See Chapter 2, “Installation Requirements,” on page 13.) List any potential discrepancies.</td>
</tr>
<tr>
<td>Problem description:</td>
<td></td>
</tr>
<tr>
<td>Did you receive any error messages or alerts? If so, what did they say?</td>
<td>If possible, take screen captures. At what point did these errors/alerts occur?</td>
</tr>
<tr>
<td>Is the problem reproducible?</td>
<td></td>
</tr>
<tr>
<td>Steps taken prior to encountering or to reproduce the problem:</td>
<td></td>
</tr>
<tr>
<td>1.</td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td></td>
</tr>
<tr>
<td>3.</td>
<td></td>
</tr>
<tr>
<td>4.</td>
<td></td>
</tr>
<tr>
<td>5.</td>
<td></td>
</tr>
</tbody>
</table>
Appendix B  Troubleshooting the Installation

Troubleshooting tools
Appendix C

Glossary of Terms

This appendix covers:

- Definition of terms .............................................. 138
## Definition of terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Client installation</strong></td>
<td>A computer installed with the GeneMapper® ID-X Software only (software with no database). A client installation computer connects to a full installation computer to access the multi-user database. A client can be installed on a Data Collection (DC) computer, or it can be installed on a non-Data Collection (non-DC) computer in either a remote autoanalysis or stand-alone configuration.</td>
</tr>
<tr>
<td><strong>Co-installation (31xx, 3730, 3500)</strong></td>
<td>A full or client installation (database and GeneMapper® ID-X Software) on a Data Collection computer that can be set to communicate locally with the Data Collection Software for the collection and processing of .fsa sample files (31xx or 3730) or .hid sample files (3500), and for the analysis of data. Co-installation with full GeneMapper ID-X software is not recommended in a multi-user database configuration because the multi-user host is limited to a one-client-connection.</td>
</tr>
<tr>
<td><strong>Dashboard (3500)</strong></td>
<td>The Dashboard displays gauges, instrument information, consumable information, and maintenance notifications that provide a quick overview of the usage of each consumable and the status of the 3500 computer.</td>
</tr>
<tr>
<td><strong>Data collection client installation</strong></td>
<td>An installation (GeneMapper® ID-X Software only) on a Data Collection computer that can be set to communicate locally with the Data Collection Software for the collection and processing of .fsa or .hid sample files, and for the analysis of data. Connects to a multi-user database host computer to access, analyze, and share data and analysis settings.</td>
</tr>
<tr>
<td><strong>310 Data Collection (DC) computer</strong></td>
<td>A stand-alone computer with Data Collection Software that controls the Genetic Analyzer instrument and generates .fsa sample files used for analysis by the host or client computer GeneMapper® ID-X Software.</td>
</tr>
<tr>
<td><strong>31xx or 3730 Data Collection (DC) computer</strong></td>
<td>A computer with Data Collection Software that controls the Genetic Analyzer instrument and generates .fsa sample files used for analysis by the host or client computer GeneMapper® ID-X Software. Can support a co-installation or client installation.</td>
</tr>
</tbody>
</table>
### 3500 Data Collection (DC) computer
A computer with Data Collection Software that controls the Genetic Analyzer instrument and generates .hid sample files used for analysis by the host or client computer GeneMapper® ID-X Software. Supports a co-installation and client installation.

### Data Collection Software
The software on the Data Collection computer that controls the Genetic Analyzer instrument and generates the .fsa or .hid (3500) sample files used for analysis.

### Full installation
A computer installed with both the multi-user database and GeneMapper ID-X Software.

A full installation computer can be part of a multi-user database configuration, or it can be a data collection (DC) or non-data-collection (non-DC) computer having no interaction with other computers. A full installation can occur in any of the following configurations, depending on the function of the computer:

- Co-installation
- Remote Autoanalysis
- Stand-alone

### Genetic analyzer
The capillary electrophoresis instrument, controlled by the Data Collection Software, which generates .fsa or .hid sample files (.hid on the 3500).

### GMID
Abbreviation for GeneMapper® ID Software.

### GMID-X
Abbreviation for GeneMapper® ID-X Software.

### Local area network
A communications network that serves users within a confined geographical area.

### Local autoanalysis
A co-installation (database and GeneMapper® ID-X Software) or client installation (GeneMapper® ID-X Software only) that is set up on a Data Collection computer to locally communicate with the Data Collection Software for the collection and processing of .fsa sample files, and the analysis of data.
Appendix B  Glossary of Terms

Definition of terms

**Multi-user database host computer**
A computer on which data is stored on a central, multi-user database. Commonly referred to as the host computer, from which other client computers (computers without a database) can access, analyze, and share data. Can be installed for a remote autoanalysis or stand-alone (non-DC) configuration.

**Non-Data Collection (non-DC) computer**
A non-Data Collection computer that may or may not be connected to a local area network (LAN). Can be a client installation or full installation, with a stand-alone or remote autoanalysis configuration.

**Stand-alone configuration**
A full installation (database and GeneMapper® ID-X Software) or client installation (GeneMapper® ID-X Software with no database) on a non-Data Collection computer that does not remotely communicate with the Data Collection computer. Can be the database host or client computer in a multi-user database configuration.

**Upgrade installation**
A software upgrade from GeneMapper® ID-X Software v1.0/1.0.1/1.1/1.1.1 to GeneMapper® ID-X Software v1.2. The upgrade can be performed on a client or full installation computer that already has the v1.0/1.0.1/1.1/1.1.1 software installed. However, to upgrade on a client computer, you must also upgrade the computer that hosts the full multi-user database installation.

**Remote autoanalysis**
A full or client installation on a non-Data Collection computer that is set up remotely to communicate with the Data Collection computer (Data Collection Software) for the automatic acquisition and analysis of data. Can be the database host or client computer in a multi-user database configuration.
**Documentation**

**Related documentation**

The following related documents are shipped with the system:

<table>
<thead>
<tr>
<th>Document</th>
<th>Part number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GeneMapper® ID-X Software Version 1.0 Administrator’s Guide</td>
<td>4376327</td>
<td>Describes how to configure the administrative features of the software, maintain the GeneMapper ID-X and database dashboard software, and use the command-line interface.</td>
</tr>
<tr>
<td>GeneMapper® ID-X Software Version 1.0 Getting Started Guide</td>
<td>4375574</td>
<td>Explains how to set up the software, set up a project, and analyze the example data provided with the GeneMapper ID-X Software.</td>
</tr>
<tr>
<td>GeneMapper® ID-X Software Version 1.1 (Mixture Analysis Tool) Getting Started Guide</td>
<td>4396773</td>
<td>Explains how to set up the software for mixture analysis and analyze the example data provided with the GeneMapper ID-X Software.</td>
</tr>
<tr>
<td>GeneMapper® ID-X Software Version 1.0.1/1.1 Reference Guide</td>
<td>4382693</td>
<td>Describes process quality values (PQVs) and algorithms.</td>
</tr>
<tr>
<td>GeneMapper® ID-X Software Version 1.0.1/1.1 Quick Reference Card</td>
<td>4385670</td>
<td>Provides an easy-to-follow workflow for using the mixture analysis tool.</td>
</tr>
<tr>
<td>GeneMapper® ID-X Software Version 1.2 Reference Guide</td>
<td>4426481</td>
<td>Describes process quality values (PQVs) and algorithms.</td>
</tr>
</tbody>
</table>
Obtaining information from the Help system

Portable document format (PDF) versions of this guide and all supporting documentation are available on the documentation CD available with your software.

**Note:** To open the user documentation on the CD drive, you need the Adobe® Acrobat® Reader® software, which is available from www.adobe.com or www.appliedbiosystems.com/support/software.

**Note:** For additional documentation, see “How to obtain support” on page x.

## Obtaining information from the Help system

The GeneMapper ID-X Software and the database Dashboard Software have a Help system that describes how to use each feature of the user interface. Access the Help system by doing one of the following:

- Click in the toolbar of the GeneMapper® ID-X Software or database Dashboard Software window.
- Select Help » Contents and Index.
- Press F1.

You can use the Help system to find topics of interest by:

- Reviewing the table of contents
- Searching for a specific topic
- Searching an alphabetized index
Send us your comments

Applied Biosystems welcomes your comments and suggestions for improving its user documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is for submitting comments and suggestions relating only to documentation. To order documents, download PDF files, or for help with a technical question, see “How to obtain support” on page x.
Index

Numerics
31xx autoanalysis 81
31XX, 3500, or 3730 Data Collection computer 81
client installation 51
3500 autoanalysis 95
3730 autoanalysis 81

A
administrator privileges 40, 49
custom profiles 82, 96
logging on 29, 40, 49, 127
allelic ladder, Results Group 85
analysis parameters, sample run 92
Applied Biosystems
contacting x
customer feedback on documentation 143
Information Development department 143
Technical Support x
autoanalysis
autoanalysis manager definition 76
autoanalysis manager for remote autoanalysis 80
configuration components 76
instrument protocol 82, 96, 100
process 74
running 94
setup on 31XX or 3730, following installation 81
setup on 3500, following installation 95
user accounts 81

B
backing up data 22

C
changing installation configurations 79
client installation 14
computer requirements 18
connecting to new host 68
DOS window 57
installation time 18
installing client 49
local area network 49
log file 125
monitor requirements 18
on 31XX, 3500, or 3730 Data Collection computer 51
on Data Collection computer 78
on non-DC computer 49, 51
operating system requirements 18
optimizing data sharing 103
troubleshooting 124
collecton
on Data Collection computer 78
uninstalling GeneMapper® ID-X software 126
computer requirements
administrator privileges 29, 40, 49, 127
client installation 18
Ethernet, full installation 16
full installation 16
monitor, full installation 16
operating system, full installation 16
user accounts 40, 49
verifying setup 19
verifying user accounts 41, 49
computer setup
  verifying 19
connecting to new host, client 68
custom profiles, setting privileges 82, 96
customer feedback, on Applied Biosystems documents 143

D
Data Collection client installation
  uninstalling GeneMapper® ID-X software 126
Data Collection computer
  client installation 78
  co-installation 78
  computer name 35, 45, 55
  enabling autoanalysis 31
  Generic Updater Software 118
  local autoanalysis 44
  synchronizing software 115
Data Collection Software
  enabling autoanalysis 31
  fsa sample files 44, 54
  Results Group 84
  Results Group and Plate list 85
  service console 32, 48, 57, 128
  starting manually 33
  starting on 31XX or 3730 computer 32
  starting on 3500 computer 34
  stopping 48, 57, 128
  verifying error-free startup 33
data options, instruments 20
  data sharing 103
  data sharing

remote autoanalysis 103
define plate properties 100
destination folder, selecting 46, 56
domain name 41, 49
DOS window
  client installation 57
  during full installation 48
dye set 82

E
enabling autoanalysis
  co-installation 31
  remote 31
Ethernet requirements, full installation 16
exporting data 22
  automatically 24
  error messages 26
  manually 24, 61
  projects 71

F
folder privileges
  client installation 58
  resetting permissions 58
fsa sample files
  Data Collection Software 44, 54
  in Results Group 84
  reassociating 103, 114
  remote autoanalysis 44, 54
  shared folder 92, 104
  sharing 89, 103, 104
  storing 89, 103, 104
full installation
  computer requirements 16
  DOS window 48
  Ethernet requirements 16
  installation time 17
  log file 125
  monitor requirements 16
  new 14
  troubleshooting 124
GeneMapper® ID export utility 22
GeneMapper® ID-X
  login 67
  logout 70
GeneMapper® ID-X v1.1
  upgrade installation 60
GeneMapper® Software
  login 67
  logout 70
  registration code 66
Generic Updater Software
  installing 118
  on Data Collection computer 118
  uninstalling 120
generic analyzer
  data options 20
  instrument compatibility 20
  operating system compatibility 77
  software compatibility 77

host computer name
  enabling autoanalysis 31

importing projects 71
Information Development department,
  contacting 143
installation problems, troubleshooting 125
installation time
  client installation 18
  full installation on data collection
    computers 17
  full installation on non-data collection
    computer 17
installer
  client 14, 58, 118
  resetting permissions 58
  specifying folder privileges 58

upgrade 14
installing software
  remote autoanalysis, non-DC
    computer 45
  instrument compatibility
    operating system 77
    software 77
instrument protocol 92
  creating 82, 96, 100
  dye set 82
  for autoanalysis 82, 96, 100
  name 82
  protocol name 82
  run module 82
  run type 82

local area network
  client installation 49
  login requirements 49
local autoanalysis
  31XX, 3500, or 3730 Data Collection
    computer 44
  Data Collection computer 44
log file 125
login
  GeneMapper® ID-X 67
  GeneMapper® Software 67
  password 67
logout
  GeneMapper® ID-X 70
  GeneMapper® Software 70

minimum computer requirements
  software installation 19
  System Properties dialog box 19
monitor requirements
  client installation 18
  full installation 16
MSDSs, obtaining x
Index

multi-user database
  autoanalysis components 76
dating sharing 103
  obtaining host name 37
  optimizing data sharing 103

N
non-DC computer 51
NTFS permissions, setting manually 58

O
operating system requirements
  client installation 18
  full installation 16
  optimizing data sharing 103

P
password, creating
  for GeneMapper® ID-X v1.0 67
password, reusing 60
performing autoanalysis 94
permissions, setting 58
plate
  properties 100
plate dialog 92
Plate Editor, for autoanalysis 92
plate name 92
plate records, specifying
  analysis parameters, for sample runs 92
  for autoanalysis 92
  instrument protocol 92
  Results Group 92
plate records, synchronizing software 92, 115

R
reassociating fsa sample files 103, 114
registration code, software 66
remote analysis
  optimizing data sharing 103
  remote autoanalysis
    Autoanalysis Manager 80
    changing installation configurations 79
    Data Collection computer name 35, 45, 55
    data sharing 103
    installing on non-DC computer 45
    saving fsa sample files 44, 54
    uninstalling GeneMapper® ID-X software 126
resetting folder permissions 58
Results Group and Plate list
  allelic ladder 85
  Data Collection Software 85
Results Group, creating for autoanalysis 84, 92
reusing existing password 60
run folder 92
run module 82
run type 82

S
sample run, analysis parameters 92
service console 48, 57, 128
  starting Data Collection Software 32
software installation
  minimum computer requirements 19
  software registration code 66
starting Data Collection Software 32
synchronizing software 92, 94, 115

T
technical support
  checklist 131
  contacting 131
  login, client installation 49
  needed information 131
training, information on 131
troubleshooting
  disabling firewall settings 124
obtaining log file 125
technical support checklist 131
uninstalling software 124

U
uninstalling GeneMapper® ID-X software
co-installation 126
Data Collection client installation 126
multi-user database 126
remote autoanalysis 126
uninstalling GeneMapper® ID-X v1.0 software
changing installation configurations 79
uninstalling GeneMapper® ID-X v1.0 software
co-installation 127
Data Collection client installation 127
uninstalling GeneMapper® ID-X v3.x software 22, 28
uninstalling Generic Updater software 120
upgrade installation 14
GeneMapper® ID-X v1.1 60
reusing password 60
user accounts
connecting to new host 68, 81
creating 71, 81, 95
for autoanalysis 81
full installations 40, 49
multi-user database 68
verifying domain name 41, 49
user attention words, definitions ix
user guide
attention words ix
audience viii
text conventions viii
**Worldwide Sales and Support**

Applied Biosystems vast distribution and service network, composed of highly trained support and applications personnel, reaches 150 countries on six continents. For sales office locations and technical support, please call our local office or refer to our Web site at [www.appliedbiosystems.com](http://www.appliedbiosystems.com).

**Headquarters**

850 Lincoln Centre Drive
Foster City, CA 94404 USA
Phone: +1 650.638.5800
Toll Free (In North America): +1 800.345.5224
Fax: +1 650.638.5884

12/2009